
Getting Started
Welcome to Getting Started in Family Matters. Family Matters provides you the ability to 
maintain your detailed family Genealogy information using a Lineage- and Event- Linked 
Relational Database powered by the Microsoft Jet Database Engine. Family Matters is a 
Microsoft Access 97 run-time application, with all the necessary run-time programs supplied, 
supporting Multiuser Genealogical Computing. It provides you (and your workgroup) a variety of 
means of viewing and accessing the genealogical information vital to your Family History.

Before you begin using Family Matters, you should read this Help topic completely. It will give a 
good feel for the capabilities of Family Matters, and provide links to other relevant topics in the 
Help file. If you choose, you can use to browse buttons above to read though every topic in 
Help.

The first screen you will see upon starting Family Matters will include the Menu and Toolbar. You
will be able to drag, resize, and dock the Menu and Toolbar anywhere on the screen. Also, you 
can customize the contents and appearance of the Toolbar.

Your choice of database file is made by using the File menu on this screen. The File menu also 
has entries for starting a New database, data Import and Export, database management, and 
saving a backup of your work. Each file has the capacity to hold an unlimited number of 
persons, families, spouses, children, and inter-relationships. If you have data from another 
genealogy program, you can utilize Family Matters’ GEnealogical Data COMmunications 
(GEDCOM 5.5) file import and export.

You may have as many database files as you desire. (Prior to registration Family Matters will 
limit you to twenty families per file, though without limit to the number of people.) You will want 
to choose New. Then choose a file name that has meaning to you, like MyFamily.mdb or 
Genealogy.mdb. Note that Family Matters will remember the file that you last had open, thus 
obviating the need to perform the File Open again.

You may open any of the data views you like, and have as many open simultaneously as you 
like. There are no separate windows for data entry; all views support data entry, editing, and 
browsing. Most of your time will be spent on the Family Group View. This view demonstrates the
power of the Linked Relational Database used by Family Matters. The persons shown on this 
view are linked because they are a family. However, you will be working with the actual data of 
six persons (primary, spouse, and both their parents), plus all their children; as many as this 
couple might have had. Additional related views you may use are Family Matter’s unique 
Family, Person, Picture and Event views.

The Options Dialog provides a means to customize the appearance of the Views and the Status
Bar, and to set other default behaviors. You may open this from the Tools menu. Of particular 
import is Family Matters' ability to vary the screen size of view objects to allow you to control the
amount of data displayed on the screen resolution you are using. You should do this to strike a 
compromise between displayed font size and amount of data (e.g., children, notes) displayed. 
Based on you option settings, as you resize windows, view fields and buttons will automatically 
resize in accordance with your computer screen resolution.

You will want to begin entering data in the Family Group View, one of the many data views in 
Family Matters. Enter your own name in the Primary person area. Enter first name (or given 



name), then surname on the right. Under that, enter the Relationship that this person is to you (if
it is you, enter Self) and then choose either male or female (m, f, or unknown). Later, you’ll use 
the Relationship Calculator to determine the relationship of persons in your family to you.

The next two lines (F and M) are for the birth dates and names of the Father and Mother of the 
Primary person. You will enter the parents’ names before Family Matters will allow their birth 
date entry. The fifth line is for birth event information. The fields are birth date and place of birth. 
You would simply enter the date as dd mmm yyyy if you have data indicating the date you are 
entering is exact. If an estimated date, or one you are not sure of, proceed the date with a 
qualifier like ‘Est’ or 'Abt'. The next scrollable section (the event subform) is for the other events 
associated with this person. There is no limit to the number of events. 

The Spouse section fields are arranged the same as for the Primary person. Enter the spouse 
data in these fields. This would be your own spouse, if you entered yourself as Primary.

In the next section, another embedded scrollable subform allows entry of the events pertaining 
to this family. A likely event is marriage and the date and place. Again, the drop-down list shows 
you the event possibilities. Note that you can add to the types of events by using the Event 
Dictionary. Family Matters provides the capability for an unlimited number of events, and user-
defined events, for persons and for families. There is also a unique Event View, where events 
can be filtered, sorted, and printed every which way.

The Children subform section is arranged similarly. On the first line, enter the birth date, first 
name, and surname. The second line is for sibling number, place of birth, and sex. Family 
Matters will display the children in birth order (if birth dates have been entered) or sibling 
number (if entered) the next time you show this view. Initially, the children will be displayed in 
the order you enter them. If birth dates are known, there is no need for you to enter a sibling 
number, unless you wish to. There is no limit to the number of children in a family.

The three Notes sections are typical of these types of areas in Family Matters. The three on the 
Family Group View are associated with the Primary, the Spouse, and the Family. Each can hold 
over 2-billion characters of free-form text. You can put any data in these sections that suits you. 
Below the Notes fields, you can include photographs of families and family members.

You are now ready for the first automatic feature of Family Matters. Decide for whom you will 
next enter data. Choose a person for whom you have entered the first name and surname for on
this view. This will be either a child, or either the Primary person's parent or Spouse's parent. 

When you click the button to the left of the name of a child or parent, Family Matters will take 
you to (will display) the family record for the chosen person. Since this family record doesn't yet 
exist, Family Matters will next ask you if you wish to create a family record for that person. Click 
on Yes. The newly created record will present the same information that was displayed currently,
but arranged from the point of view of the person whose button you just clicked.

In this way, Family Matters will assist you in navigating among family members and in creating 
records of new family members. You have thus begun the creation of the Family Matters 
database of lineage-linked persons and families. You will have sequential, lineage, and random 
access of families and family members.

You can copy and paste persons and events in Family Matters. This is facilitated by the right-
button mouse shortcut menus. When a person-oriented field has the focus, there will be person 



link copy and paste choices available to you. The action of pasting a copied person link does 
not actual create another person, but rather links that person into a new relationship. On the 
other hand, the act of copying and pasting events does in fact create a new event, but now 
associated with a different person or family. Likewise, persons and events can be deleted and 
unlinked though the use of the shortcut menus.

You can link pictures stored in your computer to the persons in your database. Each person can
be linked to an unlimited number of pictures, and each picture can be linked to an unlimited 
number of persons. The Picture View is where the pictures are displayed, and where the links to
and from persons are managed. Every view in Family Matters with a person supports the Show 
Picture action. Choosing it from the right-button menu causes the Picture View to select all the 
pictures linked to that person.

When you have data you would like to include, but it applies to a location, or a period of time, 
the Chronicles database is what you need. Perhaps you'll want to describe your ancestors way 
of life in Europe, and what caused them to emigrate. Maybe you want a place for the origins of 
your family name. Perhaps you want a place to accumulate everything you know about region 
around the Rhine and Alsace-Lorraine and Baden-Wüerttemburg, because that's where your 
roots are. Family Matters' Chronicles database is exactly what you need. You can even 
designate parts of this database to become a part of your Web Site, along with your ancestors.

You can also document your Source data, and the Repositories in which it is kept. The Source 
View and the Repository View provide the means to do this. Source data if the actual data that 
you have uncovered in an old family bible, from census records, birth certificates, or any other 
source. This is the data upon which you have made decisions about the relationships and 
events of the people you have placed in you database. 

You will want to generate printed reports of your work. The Reports and Print dialog provides a 
means to both preview and print all of the reports available in Family Matters. You may open this
dialog by use of the Print entry on the File menu, or the Printer button on the Toolbar. 
Additionally, use the Reports menu item, and many data views contain Quick-Print buttons to 
print the current record or records displayed. 

Other features of Family Matters that will assist your research and use of Family Matters. 
Include the    Web Site Generation with Gendex distributed Internet database capability, the 
powerful search and replace functions, including the use of extensive wildcards, the ability to 
QuickSort on any displayed field view in any displayed view, and the use of the built-in 
genealogical tools such as the Soundex, birth date, and relationship calculations.

To read more about the other features of Family Matters, click the highlighted links above, or 
click on the ‘>>’ button above to advance to the next topic, and the ‘<<’ button to return to the 
previous topic.



Customizing Your Environment
Use these options to set the characteristics of your Family Matters environment. The Options 
dialog is available from the Tools Menu. Also from Options, on the Tools menu, you can 
customize the appearance of your toolbar. Specifically, you can chose which view-open buttons 
appear, and their appearance. Depending on your screen size and resolution, you may desire 
fewer buttons, or the button names to be either brief or verbose.

General Tab

Show Status Bar: Yes or No. Displays or doesn't display the status bar. When on, the field 
data entry messages will appear. Also, the right hand sections shows the status of CAPS, 
INS, and NUM.

Confirm Deletes and Unlinks: Yes or No. Displays or doesn't display a confirmation 
message box when you Delete or Unlink persons. If the person you are operating on has 
other linkages in the database, not currently displayed, an additional confirmation will be 
requested, with the number and types of linkages (spouse, father, mother). If this option is 
set to yes, this confirmation is always displayed.

Default Search Behavior: Fast Search, General Search, or Start of Field. Sets the default 
behavior for find and replace operations. Fast Search searches the current field and 
matches the whole field. Start of Field matches against just the first characters in the field. 
General Search searches all fields and matches any part of the field. Changes made to this 
setting don't take affect until the next time you start. To change the behavior for a specific 
find or replace operation, choose Find or Replace from the Edit Menu, or the Toolbar, and 
then set the appropriate options in the dialog box.

Text Editor: Write, NotePad, WordPad, or any other. The choice of which editor you would 
prefer to use can be modified here. External text files can be edited and cut of pasted into 
or out of Family Matters.

Views Tab

Vertical Scale Factor:    60% to 110%. Sets the vertical display scale factor on many of the 
data views such as the Chronicle, Event, Family, Group, Person, and Repository. You can, 
for instance, maximize the number of children displayed to you on the Family Group View 
by setting this value smaller.

The most desirable settings for a 1024 x 768 resolution display, at 96 logical dots per inch 
(dpi), is 100% scaling, and 10 point font. If you have a VGA (640x480) or SVGA (800x600) 
display, Family Matters has initially set these to lower values. Generally, to maximize the 
amount of data displayed, you should adjust the font to the smallest value you can 
comfortably view. You should then adjust the corresponding Vertical Scale Factor to the 
smallest value that properly displays your chosen font size.

Font Size:    6 to 11. Sets the text font size on the data views other than the Pedigree View. 
Additionally, the Picture, Source, Person List and Family List views will resize themselves 
based upon this setting.



Date Field Width:    Set displayed width. With your cursor in this field, use your up and 
down arrow keys to increase and decrease the space used for date displays on the data 
views other than the Pedigree View.. Also, you may use any sample date text you choose to
verify your setting.

Pedigree Vertical Scale Factor:    Auto, and 60% to 110%. Sets the vertical display scale 
factor on the Pedigree View. You can fix the scaling to a value you feel comfortable with, or 
set it to Auto, which will resize the view’s objects whenever you vertically resize the window
it’s displayed in.

Pedigree Font Size:    6 to 11. Sets the text font size on Pedigree View.

Pedigree Date Field Width:    Set displayed width. With your cursor in this field, use your 
up and down arrow keys to increase and decrease the space used for date displays on the 
Pedigree View. Also, you may use any sample date text you choose to verify your setting.

Show Navigation Buttons: The Record Navigator bar, if enabled, provides another way for
records to be browsed. It is located at the bottom of a number of the data Views.

Use System Colors: Family Matters gives you the option of using the Windows system 
colors you have chosen for all your screens and applications, or use a set of colors known 
as the FM Classic colors.

Toolbar Tab

You can choose which view-open buttons appear, and their appearance. Depending on 
your screen size and resolution, you may desire fewer buttons, or the button names to be 
either brief or verbose. The first column is where you indicate whether or not you want the 
button to be visible. In the second column you indicate the button text. Note that changes 
you make are immediately visible on the toolbar.



Using The Keyboard
Editing and Control Keys
Press To
Ctrl+C Copy the selection onto the Clipboard.
Ctrl+F Open the Find dialog box.
Ctrl+H Open the Replace dialog box.
Ctrl+V Paste the contents of the Clipboard at the insertion point.
Ctrl+X Cut the selection and copy it onto the Clipboard.
Ctrl+Z or    
Alt+Backspace Undo typing.
Esc Undo changes in the current field or current record; if both have 

been changed, press Esc twice to undo changes; first in the 
current field and then in the current record.

Backspace Delete the selection or the character to the left of the insertion 
point.

Delete Delete the selection or the character to the right of the insertion 
point.

Function Keys
Press To
F1 Display context-sensitive Help related to the active window.
Shift+F1 Display the question mark pointer. Move the pointer to the window 

you want help on, and click for context-sensitive Help.
F2 Switch between editing mode (with insertion point displayed) and 

navigation mode.
F4 Open a combo box or list box.
Shift+F4 Find the next occurrence of the text specified in the Find or 

Replace dialog box when the dialog box is closed.
Ctrl+F4 Close the active window.
Alt+F4 Quit Family Matters, or close a dialog box.
F6 Cycle forward through the data section, list section, and footer of a

window such as the Person View.
Shift+F6 Cycle backward through the header, data, and footer sections of a 

window.
F7 If you have Microsoft Office 97 installed, this will call upon the 

Spell Checker.
Ctrl+F6 Cycle between open windows.
F8 Turn Extend mode on; EXT appears in the status bar. Once 

Extend mode is on, pressing F8 repeatedly extends the selection 
to the word, and the field.

Shift+F8 Reverse the F8 selection; press Esc to cancel Extend mode.
F9 Activate an OLE object.
Shift+F9 Requery the underlying tables; pressing Shift+F9 in a child or 

event record reorders the children or events according to your 
entries.

Alt+Spacebar Displays the Control menu.

Cursor Movement and Navigation
Press To



Page Up Previous record (or group of displayed records).
Page Down Next record (or group of displayed records).

To Move The Insertion Point Within a Field or Line (In Editing Mode)
Press To
Right Arrow Move one character to the right.
Ctrl+Right Arrow Move one word to the right.
End Move to the end of the line.
Ctrl+End Move to the end of the field in multiple-line fields.
Left Arrow Move one character to the left. 
Ctrl+Left Arrow Move one word to the left.
Home Move to the beginning of the line.
Ctrl+Home Move to the beginning of the field in multiple-line fields.

To Navigate Between Fields and Records (In Navigation Mode)
Press To
Tab, Right Arrow, or Enter Move to the next field. The Enter key will start a new line in the 

Group View Notes areas, and the Pedigree View’s 2nd title.
Shift+Tab Move to the previous field.

To Navigate In a Text Box 
Press To
Down Arrow Move down one line.
Up Arrow Move up one line.
End Move to the end of the current line.
Ctrl+End Move to the end of the last line.
Home Move to the beginning of the current line.
Ctrl+Home Move to the beginning of the first line.

To Select Text Within a Field (In Editing Mode)
Press To
Shift+Right Arrow Extend the selection or deselect one character to the right.
Ctrl+Shift+Right Arrow Extend the selection or deselect one word to the right. 
Shift+Left Arrow Extend the selection or deselect one character to the left.
Ctrl+Shift+Left Arrow Extend the selection or deselect one word to the left. 

To Select a Field
Press To
F2 Select the current field if you are in editing mode.
Tab or Enter Select the next field.

Shortcut Keys for Data Entry
Press To
Ctrl+; (semicolon) Insert the current date.
Ctrl+: (colon) Insert the current time.
Ctrl+' (quote) Insert the value from the same field in the previous record.
Ctrl+Enter Insert a new line in a field, a label, or the Zoom box.
Ctrl++(plus) Add a new record.
Spacebar Toggle the value in a check box or option button.



Print Preview Function Buttons
Press To
P Print the active object.
S Open the Setup dialog box.
Z Zoom in for a magnified view of part of the page.
C or Esc Cancel Print Preview.

To View Different Pages In Print Preview
Press To
F5 Move to the page number box; then type the page number you 

want to go to and press Enter.
Page Down Move to the next page.
Page Up Move to the previous page.

To View Different Parts of a Preview Page While Using Zoom
Press To
Down Arrow Scroll down in small increments.
Page Down Scroll down in large increments.
Ctrl+Down Arrow Move to the bottom of the page.
Up Arrow Scroll up in small increments.
Page Up Scroll up in large increments.
Ctrl+Up Arrow Move to the top of the page.
Right Arrow Scroll to the right in small increments.
Ctrl+Right Arrow or End Move to the right edge of the page.
Ctrl+End Move to the lower-right corner of the page.
Left Arrow Scroll to the left in small increments.
Ctrl+Left Arrow or Home Move to the left edge of the page.
Ctrl+Home Move to the upper-left corner of the page.



Using The Menus
There is one Family Matters Menu which is always displayed. Depending on the particular 
situation, some of the selections will not be functional, but instead will be disabled, or will cause 
an informational message to appear. 

File
New FM Database Create and open a new Family Matters database.
Open a FM Database Open an existing Family Matters database.
Save a Backup Save your work in a new Family Matters database. The current 

database file remains open.
Compact Database Compact the current Family Matters database.
Repair Database Repair the current Family Matters database.
Upgrade Database Upgrade the current Family Matters database to the current level. 

You will be notified if this is necessary when you open a database 
file.

Print Open the Print dialog box. 
GEDCOM Import/Export Import or export data from/to another genealogy program 

database.
Web Site Generation Generate all the files necessary for a genealogical World Wide 

Web site.
Exit Exit Family Matters.

Edit
Save Record Save the currently displayed record.
Undo Undo the entries since record saved.
Undo Current Field Undo current field changes.
CutCut highlighted text to clipboard.
Copy Copy highlighted text to clipboard.
Paste Paste text from clipboard.
Delete Delete highlighted text.
Find Open the Find dialog box.
Replace Open the Replace dialog box.

Records
Go To First Go to the first record of the current view.
Go To Last Go to the last record of the current view.
Go To Next Go to the next record of the current view.
Go To Previous Go to the previous record of the current view.
Go To New Go to the new (last) record of the current view.
Go To Home Family Go to the Home family record of the current view.
Set Home Family Sets the Home family record.
QuickSort Ascending Causes the active view to sort ascending on the currently 

highlighted field.
QuickSort Descending Causes the active view to sort descending on the currently 

highlighted field.
Show All Records Shows and re-orders the records in the current view. Cancels the 

QuickSort.

Tools



Spelling If you have Microsoft Office 97 installed, this will call upon the 
Spell Checker.

Statistics Count the number of families, persons, events, and other objects 
in you database.

Date Calculator Open the Date Calculator Tool.
Event Dictionary Open the Event Dictionary View.
Relationship Tool Open the Relationship Calculator Tool.
Soundex Open the Soundex Calculator Tool.
Sort Family Records Sorts Family records according to formation date.
Options Open the Options dialog box.

Views
Close All Close the current database views.
Chronicles Open the Chronicles View.
Descendancy Open the Descendancy View.
Event Open the Event View View.
Family List Open the Family List.
Family Open the Family View..
Group Open the Family Group View.
Pedigree Open the Pedigree View.
Person List Open the Person List.
Person Open the Person View.
Picture Open the Picture View.
Repository Open the Repository View.
Source Open the Source View.
Size and Position Remember, Forget or Recall the current View window size and 

screen position.

Reports
Close All Close all open report previews, and the Print Contol.
Chronicles Open the Chronicles preview.
Descendancy Open the Descendancy report preview.
Event List Open the Event List report preview.
Family List Open the Family List report preview.
Group, Family Open the Family Group report preview.
Pedigree Open the Pedigree Chart preview.
Person Open the Person report preview.
Person List Open the Person List report preview.
Picture Open the Picture report preview.
Repository Open the Repository preview.
Source Open the Source preview.
Size and Position Remember, Forget or Recall the current Preview window size and 

screen position.

Window
TileTiles the currently open windows.
Cascade Cascades the currently open windows.
Arrange Icons Arrange icons for minimized windows.
Size to Fit View Size the current window to just fit the displayed view.
Current Window List Choose a currently loaded window to re-activate.



Help
Registration Name, Location, UserID and Key Code entry.
Contents Display the Help Table of Contents.
Search Search for Help on a topic.
Display Hints Show the current Hint.
About Display About Family Matters.



Using The Toolbar
The toolbar is the type that you can drag anywhere on the screen. Pull on its borders, and you 
can change its shape. Leave it in the middle, put it on the bottom, put it on one side. You can 
hide it altogether by clicking your right mouse button while pointing at it, and selecting hide. It 
will reappear, however, when the next view is opened.

Customizing the Toolbar
From Options on the Tools menu, you can customize the appearance of the toolbar. Specifically,
you can choose which view-open buttons appear, and their appearance. Depending on your 
screen size and resolution, you may desire fewer buttons, or the button names to be either brief 
or verbose. The first column is where you indicate whether or not you want the button to be 
visible. In the second column you indicate the button text. Note that changes you make are 
immediately visible on the toolbar.

Save Record - Saves your edits of the current record. Also, records are automatically saved as 
you move from one to another.

UnDo - Undo your last edits.

UnDo Current Field/Record - Undo on a larger scale. Careful, there's no undo undo.

Find, Find Next, Replace - Find or replace any text string in your entire database, in whichever 
view is active. Use the Options Dialog to set the default search behavior.

Go To First, Previous, Next Record, or Last Record - Just like they suggest; navigate the 
database sequentially.

Home - Go directly to the Family record you have designated as ‘Home’ for this database file. If
no Home family has been designated as yet, you will be prompted to choose a home family. The
Records menu allows designation of a new Home record. Each database file can have a Home 
family designated.

New - Create a new chronicle, family, pedigree, person, repository, or source record.

Open The Print Control - Print and preview Family Group Reports, Pedigree Reports, a 
number of List reports, and other items. 

Editor - Opens a text editor program window for pasting or collecting of external text data. The 
choice of which editor you would prefer to use (e.g., Write, NotePad, WordPad) can be modified 
on the Options Dialog . Each depression will open another editor window. Successively depress 
Alt-Tab to switch between them. Release the keys when the desired window is visible.

(Note: The following buttons may or may not be visible on your Toolbar, depending on your 
Toolbar settings.)

Chronicle - Opens the Chronicles View. If already open, it becomes the active window.

Descendancy - Opens the Descendancy View. If already open, it becomes the active window.



Event - Opens the Event View. If already open, it becomes the active window.

Family List - Opens the Family List. If already open, it becomes the active window.

Family View - Opens the Family View. If already open, it becomes the active window.

Group - Opens the Family Group View. If already open, it becomes the active window.

Pedigree - Opens the Pedigree View. If already open, it becomes the active window.

Person List - Opens the Person List. If already open, it becomes the active window.

Person View - Opens the Person View. If already open, it becomes the active window.

Picture View - Opens the Picture View. If already open, it becomes the active window.

Repositories - Opens the Repositories View. If already open, it becomes the active window.

Sources - Opens the Sources View. If already open, it becomes the active window.

Close - Closes all the data view windows. 



Selected Common Topics
This section comprises a collection of topics that will apply to many aspects of your use of 
Family Matters. In some cases it is recommendations of data entry format; in other cases is an 
explanation of the entry or display alternate formats supported by Family Matters, or common 
behaviors of windows or menus.

The following topics are addressed here:
· Copy Object
· Create Family
· Dates
· Events
· Names
· Notes
· Pictures
· Quick-Finder 
· Quick-Print
· Record Navigator Bar
· Show Object
· Soundex

Copy Object
You can copy and paste objects such as persons and events in Family Matters. This is 
facilitated by the right-button mouse shortcut menus.

When a person-oriented field has the focus, there will be person link copy and paste choices 
available to you through the right mouse button. The action of pasting a copied person link does
not actual create another person, but rather links that person into a new relationship. Persons 
can also be unlinked and deleted through the use of the shortcut menu. Once a person is 
deleted in this manner, he or she can no longer be pasted, since the person is then no longer 
available in the database to be linked.

The act of copying and pasting events does in fact create a new event, but now associated with 
a different person or family. Events can be deleted and unlinked though the use of the shortcut 
menus. To Move an event, first Copy it, then Delete it, then Paste it where you now want it. The 
Copy Event feature is especially handy to copy events such as residence, and census from one 
family member to another.

Create Family
You may have persons in your database who have been remarried due to a divorce or were 
widowed. Family Matters’ Create Family function is what you will need. It use is facilitated by 
the right-button mouse shortcut menus available on the Family Group View and the Person 
View. Simply right-click on the person’s name, and select Create Family from the menu that 
appears. You will then see the Group View appear with the selected person as the primary, with 
his or her parents shown, and with the Spouse space available for the new husband or wife.

Dates
The topic of date recording is an important one in genealogy. In genealogical programs, the date
is not only used for the simple entry of a fact, but also for sorting and selection of information. 
Unfortunately, the fact that we don’t always know exact dates, we are sometimes interested in 



ranges of dates, and that there have been calendar variations, makes dates a sometime-
complex topic. The following paragraphs address the handling of date entry and presentation in 
Family Matters, as well as the result used in the sort and selection algorithms.

The most common date that you will be using and viewing will be in the canonical form of ‘d 
mmm yyyy’. These fields respectively indicate one or two digits for the day, three letters for the 
month, and four digits for the year.    The date 12 Apr 1947 conforms to this format. Family 
Matters will accept and display a number of shortened formats (as well as some longer and 
more complex formats, which will be addressed later). Sometimes, entries of simply 1947, or of 
Apr 1947 are more appropriate. These formats will be displayed as entered, and will sort at the 
beginning of the respective time period (Jan 1, 1947 and April 1, 1947 for the example).

Dates can be entered in formats that are quicker to enter, or that you may be more comfortable 
with, though they will always display as described above. You can enter 3/4/91. Depending on 
your Windows International Date settings, this will result in 4 Mar 1991, or 3 Apr 1991. Note that 
the 91 for the year was interpreted as being in this century. Date entry without the year specified
will be presumed to be this year. And the shorthand entry of ctl-semi-colon will result in today’s 
date.

Because the above examples contain no qualifiers, they are called exact dates. There is a set of
qualifiers with Family Matters you can pre-pend to an exact date. Every date entered in Family 
Matters can have a corresponding date qualifier field. If you omit it, it is to indicate that that you 
believe the date value entered is both valid and exact. If the date is an estimate, then proceed 
the date with 'Est' or 'Abt'. Use the associated Notes area to indicate the basis of your estimate. 
If you calculated the date from another date, use 'Cal' as the qualifier. If you only know that the 
date is before or after an exact date, use 'Bef' or 'Aft' as the qualifier. 'Int' for interpreted also 
may be used.

The date form you enter, and the qualifier used, has an effect on presentations which are sorted
by date.    The ‘exact’ date sort order is yyyy, then mmm yyyy, then d mmm yyyy. Hence, first 
comes 1880, then Jan 1880, then 1 Jan 1880. A sub-set of the qualifier sort order is (as you 
would expect) Bef, then unqualified, then Aft. In practice, looking at the end of 1880, the 
ordering would be 31 Dec 1880, Aft 31 Dec 1880, Aft Dec 1880, Aft 1880, Bef 1881, 1881, Bef 
Jan 1881, Jan 1881, Bef 1 Jan 1881, and 1 Jan 1881. Note also that Aft Jan 1881 will sort after 
31 Jan 1881. The full date qualifier sort order is Bef, Abo, Cal, Est, Int, <unqualified>, and Aft. 
These qualifiers would fit between Bef 1881 and 1881.

There are also two date range formats supported by Family Matters. These are the Between 
and the From-To formats. The Between format is written Bet 1855 1865. This is an inexact form 
indicating that you don’t know the correct date, but only a range of possible years. The From-To 
format is written FrTo 1855 1865, and is used to indicate a known period, such as years lived at 
a residence, or a military service period. Both these formats sort before January 1 of the first 
year specified.

The last set of date formats supported by Family Matters involves the Julian/Gregorian Calendar
change initiated in 1582, to correct for the approximately 11 days that the calendar and seasons
has slipped since 325 AD. Unfortunately, the adoption of the Gregorian Calendar was a slow 
and uneven process. France, Spain, Portugal, and Italy immediately adopted the Gregorian 
Calendar, and 4 Oct 1582 was followed by 15 Oct 1582 in those countries. A number of other 
European countries soon followed suit, but much of Europe did not for more than a century. 
England followed suit in 1752, declaring 2 Sep 1752 to be followed by 14 Sep 1752, and 



adopting January 1 as the day when a new year begins. Still other countries and groups use the
Old Style calendar into the twentieth century. When Russia changed its calendar, 31 Jan 1918 
was followed by 14 Feb 1918 (note that the error was 14 days by this time).

During this calendar transition period, two styles of date recording were used. The recording of 
dates had (1) either NS (for New Style) and OS (for Old Style) appended to the date, or (2) a 
method of ‘double-dating’ was used. These systems are both supported for dates in Family 
Matters (except with the date range formats). Hence, the dates of 13 Jan 1730 OS, 13 Jan 1731
NS, and 13 Jan 1730/31 are equivalent, and can all be used. As a default, all dates are 
assumed to be New Style, to be in adherence with today’s use of the Gregorian Calendar.

Family Matters’ date calculator assumes that all dates entered are consistent with each other. In
other words, both dates are consistent with the same calendar. The Date Calculator is 
accessible from the Tools menu.

The width of the screen field allocated to dates is controllable using the Options Dialog. You 
may want to set the field wide if many of your dates are as long as ‘Abo 23 Jan 1730 OS’, and 
you want to always see all the text, or you may want to make the fields narrower if your screen 
presentation is small.

Events
Events are shown on the Group View, Person View, and Family View. Each event is made up of 
a type, a date and a place. These events are shown in a scrollable subform. There can be as 
many events linked to an person or family as you like. There can also be as many occurrences 
of the same event as you like (except that birth and death are limited to one each per person). 
Events are deleted by clearing both the date and place fields. You will then be asked if you wish 
to delete the event. You don't have to; you may just want to signify that an event has occurred, 
you just don't know where or when.

Names
The name fields are comprised of the first (or given) name, and the surname. The first name 
field’s capacity is 100 characters. This should be the given name a birth. If the person was also 
known by a nickname, you could enter that in this field (perhaps in quotes or parentheses), or 
use the Notes area.

The surname field allows the entry of up to fifty characters. You can enter the surname as all-
caps (i.e., SMITH), or as initial caps (i.e., Van Hooten). If initial caps are chosen 
(recommended), you will be able to choose all-caps as the output mode for certain reports. The 
name you use should be the person’s name at birth. Hence, though a woman’s name might 
have changed at marriage, you would enter it as her maiden name. 

Another term associated with name is the full-name. This will most frequently be shown as 
SURNAME, Firstname. The full-name will frequently be used in Family Matters as part of a 
unique identification of a person in the form ‘SURNAME, Firstname (birthdate)’. Since you may 
have many persons with the same or similar names, you should attempt to assign birth dates, 
using the ‘Est’ or ‘Abo’ qualifiers if necessary. This will also assist in the locating of a person in 
a sorted list, where surname is the first sort-key, and birthdate is the second.

A variation of the full-name is used on the Pedigree. This is in the form ‘Firstname Surname’. 
This is a calculated value, based on the entry of the actual name fields. You can modify the 
Pedigree name if you wish, so that it fits better on that view or report. Note that it will be re-



computed by Family Matters any time the actual first name or surname is modified on any other 
view.

Notes
Most record types have Note fields. There is a Note associated with each Person, Family, 
Repository, and Source. The Source Documentation has two notes-like fields; one for the 
Source data itself, and one for your notes about it. The Family Group View shows three Notes 
fields; one associated with the Primary person, one with the Spouse person, and one for the 
Family.

Each Notes field is a free-format text field, and allows entry of over 2-billion characters, 
including letters and numbers, for each and every person. Unlike the other text fields, 
depressing the Enter key causes a new line in Notes. The sub-title field on the Pedigree View 
also behaves like this, though it is limited to 250 characters.

Pictures
The pictures shown in the Picture View are stored elsewhere in your computer. Scanned 
photographs at 150 dpi, full color, in bmp files are the best. Greater resolution (dots per inch) 
won’t display better on a computer screen, and will be much larger files, though they may show 
better on a printed report. Other formats (like jpg) can be used, but they will take time to be un-
encoded before being displayed. Your family pictures are linked (rather than embedded), so 
they will remain in their separate files on you disk where they can be edited. Most importantly, 
they do not add size to the database file. Should you vies your database on a computer where 
the pictures are not available, they will not be able to be seen, and a message indicating that 
will appear where the picture would have.

If you previously used a version of Family Matters where pictures were embedded, they still are,
till you change them to the method now used by Family Matters 97. Since the space they once 
took up in your database file is now free, you can choose Compact from the File menu to make 
your file smaller.

Quick-Finder
Most data views have a Quick-Finder built into them. By use of one or more drop-down lists, the
Quick-Finder facility provides you a straightforward means of jumping to another record on the 
same view. There will also be a Back button, to allow you to easily return to the previously 
viewed records.

Quick-Print
In addition to the centralized Print facility, many data views have a means for you to print just a 
report associated with the current record, without print preview, or with displaying the Print 
Controls. Quick-Print provides a simple facility for you to keep your printed genealogy records 
current.

Record Navigator Bar
The Record Navigator bar, if enabled, provides another way that records can be browsed. 
Located at the bottom of all Views, it is enabled using the Options dialog. The Record Navigator 
bar contains First, Last, Previous, Next, and New buttons. The Previous and Next buttons are 
unique, however, in that the mouse button can be held down, and the associated View will 
quickly slew through all the displayed records. There is also a displayed record number. This 
represents a sequential numbering of the records currently displayed in the View. You can type 
the number of a desired record directly, and the View will immediately display that record.



Show Object Action
The Show Object action is available from many of the Views. It provides a means to ‘Show’ 
additional data associated with the current object by displaying a related view. For instance, 
from the Family Group View, it is possible to perform a ‘Show Person’ from either the Primary, 
Spouse, any parent, or any child. This action will cause the Person View to appear, and display 
detailed information about the chosen person. Likewise, from the Person View, you can choose 
to ‘Show Group’. The Show functions are always available from mouse right-button shortcut 
menus, and sometimes also from a button-ribbon on the window.

Soundex
The Soundex system was invented by Margaret Odell and Robert Russell in 1918. It is a system
whereby surnames of similar sound or spelling result in similar codes, to facilitate searching and
indexing. The system is used extensively in census record indexing. Family Matters provides 
you the soundex codes of your families’ surnames on the Family Group View, and on certain 
reports. Additional support for the Soundex system is provided by the Soundex Calculator, 
available from the Tools menu.



Viewing and Editing Your Data
The various Data Views provide you visibility into the data in your Family Matters databases. 
Each page of a view represents one, or a number of, related ‘records’ in a corresponding table 
or query, in your database. Fields are the individual data entries. A query is a selection or 
combination of tables. All of these views may be opened either by Views menu selections, 
Toolbar buttons, or though the ‘Show Object’ mechanism.

You can view and browse records by any of a number of means. The First, Last, Previous, Next,
and New records can always be accessed: via the Go To menu on the Records Menu, via the 
Go To menu on the mouse right-button pop-up menu on each View, via the associated buttons 
on the toolbar, and via the associated navigation buttons on the Record Navigator bar at the 
bottom of all Views. You can directly type the record number into the Record Navigator bar. You 
can use the drop-down Quick-Finder on many of the Views. You can use the Page Up and Page
Down keys to access the Previous and next records.

Furthermore, you can directly view related and associated records by use of the Show Object 
commands (Person, Family, Group, Repository) on the mouse right-button pop-up menu on 
each View, and the Lineage Go To buttons on Views such as the Family Group View.

The Chronicles View provides you access to a unique database.    You can chronicle the lives 
and the times of your ancestors. Describe the places they lived, their way of life, and you can 
make any number of these a part of your Web Site. Chronicles are not associated with particular
persons or families in your database; you can write about any aspect of history or geography 
you choose.

The Descendancy View provides a view of your database from the point of the descendants of 
one person. You choose the person of interest, and Family Matters will list all the persons 
descended from that person, with their spouses and children, and all indented beneath their 
respective parents. You can also control the amount of data listed for each person. There is also
an associated Descendancy Report. 

The Event View provides a unique view of all events in the database, including both family and 
person events. The Event View can be sorted by more than two dozen built-in criteria to assist 
you in your research, and in making ancestral associations. This view also provides you quick 
access to the event’s corresponding person or family via the Show Object commands. 

The Event Dictionary provides you the means of adding an unlimited number of event types, as 
well as reviewing the number of time each event type is used. All the events and roles contained
in GEDCOM 5.5, as well as the previous versions, are built into Family Matters. 

The Family List provides a summary list of all families in the database. You can open this view 
by use of the of the Toolbar, or from the Views menu. You can cause the Family Group View to 
quickly display the same family.

The Family View provides the ability to browse and edit data of all families in the database. You 
can open this view by use of the Toolbar, or from the Views menu. With the Family View you can
edit events and notes. Also, you can cause the Family Group View to quickly display the same 
family.



The Family Group View (or simply Group View) is the main data view used in Family Matters. It 
provides you access to a linked, relational database, the primary Family Matters record storage.
You may think of this view as providing one record in the family group database at a time. The 
persons shown on this view are linked because they are a family. However, you will be working 
with the actual data of six persons (primary, spouse, and both their parents), plus all their 
children. The Family Group Report also represents the same accumulation of records in the 
database. 

The Pedigree View provides you a means of viewing your database in a lineage Pedigree View. 
You will choose the person in your database to the ‘head’ of the view, and Family Matters will fill
in their ancestors and vital statistics. Each page represents one record in your pedigree 
database. There is an associated Pedigree Chart report. 

The Person List provides a summary list of all person records in the database, and quick Group 
View access to the family containing the person. All persons in your database, whether related 
to you or not, are listed with this view. The records are ordered by surname and birth date. 

The Person View provides quick Group View access to the family containing the person. All 
persons in your database, whether related to you or not, are viewable and editable with this 
view. The record are ordered by surname and birth date. 

The Picture View provides a means of organizing pictures of your ancestors and relatives. The 
records are ordered by picture title and date. The records are ordered by picture title and date. 

The Repository View provides you access to a source-related database. Repositories are those 
places like the National Archives, a particular Church in Europe, and the local Department of 
Health where the primary evidence of your ancestors rests. Maintain postal addresses, e-mail 
addresses, and Internet URLs in this database. Keep notes about your successes, failures, 
progress or even driving directions, for each repository.

The Source View provides you access to a source database. Source data is that data which 
your research has unearthed, and upon which you family members and lineage is based. You 
are also able to keep notes about the data, which could include your thoughts about the relative 
accuracy of the data, and the extent to which you have used it. The Source and Repository 
databases are linked, in that the Source Data is held at the specified Repository.



Chronicle View
When you have data you would like to include, but it applies to a place, a period of time, or way 
of life, the Chronicles database is the right place. Information such as your ancestors' way of life
in Europe, and what caused them to emigrate. Perhaps you want a place to accumulate 
everything you know about region where your roots are. You can also designate parts of this 
database to become a part of your Web Site, along with your ancestors. There is a 
corresponding Chronicles Report.

Action Buttons
The buttons across the top of the Chronicle View allow you to use the Quick-Finder, return to a 
previously viewed record, Quick-Print the current record, delete the current Chronicle from the 
database, obtain Help. 

Quick-Finder - The Chronicle Quick-Finder lists all the chronicles your database, allows 
you to choose the chronicle you may next want to go to. Selection causes the immediate 
display of the selected record, or you may hit the Enter key while the selection is 
highlighted.

Back - Step back through all the Chronicle records displayed since the view was opened.

Print - Quick-Print the Chronicle Report for the current record.

Delete - Delete the currently displayed record.

Help - Open this Help topic.

Data Fields
The data fields visible on the Chronicle View include its name, description, geographic location, 
location of this chronicle on you web site, your control of whether it is included on you web site, 
and of course the text of the Chronicle itself..

Name - A short text name of this record. This is the text that is used for the Selection Box. 
Also, if you generate a web site with Chronicles, this in the text that will be used in the 
Chronicle Index.

Description - Describe what this Chronicle is about. This could be a long version of the 
Name field.

Location - The geographic location of the place of which this Chronicle is associated. Use 
a political description, latitude and longitude, or both.

HyperTag - This is the URL of this Chronicle in you web site, if you have generated one, 
and if this Chronicle is a part of your web site.

Web Option - Here you can designate that this Chronicle be excluded from your web site, 
or governed by the Include Chronicle selection on the web site Generation dialog.

Notes - The notes section is where you Chronicle your ancestors’ lives. This view section 
can store over 2-billion characters.



Shortcut Menus
A number of functions are available on the Chronicle View via the mouse right-button shortcut 
menus. These of course include the usual text Cut, Copy, Paste, and Delete functions. 
Additionally, the functions of go to, go to chronicle, delete, and print, depending on the specific 
field which has the focus.

Go To -  This shortcut provides, like the corresponding buttons on the Toolbar and Records 
menu, access to the next, previous, first last, and new records.

Size and Position - Remember, Forget or Recall the current View window size and screen 
position. Family Matters will automatically recall the size and position each time the View is 
opened.

Delete - Like the Delete action button, this function causes the deletion of the current 
Chronicle.

Print - Like the Print action button, this function causes the Quick-Print of the current 
Chronicle.



Descendancy View
The records displayed on the Descendancy View represent the descendants of the chosen 
progenitor; the contents of the descendancy database. You may want to show the descendants 
of perhaps your Great Great Grandfather. Begin by choosing him with the combo-box in the 
view header. Every person in your database is available to be chosen. They will be listed by 
surname and by birthdate. Their birthdates are also displayed to facilitate choosing.

Once you have designated the progenitor, you can generate his or her descendants by clicking 
the Generate button. Family Matters will then automatically fill in your family's descendants. You
can choose whether you want the relationship, and place of birth and/or death included for each
person.

The Person View can operate in conjunction with the Descendancy View. When you choose 
Show Person, the Person View will immediately display the person chosen on the Descendancy
View.

There is a corresponding Descendancy Report. Before you can print the Descendancy, you 
must generate it using this View.

Descendancy Options
You can choose the content of data shown for each person, and you can limit the persons 
shown to only those with the same surname or soundex code.

Include Relationships - Choose whether you want the text you put in the Relationship field
printed in parentheses after the persons name.

Include Where Born - Choose whether you want this each person's birth place printed 
after their birth date.

Include Where Died - Choose whether you want each person's place of death printed after
their date of death. Note that available Burial or Cremation data will be used if the Death 
data is incomplete.

Include Where Married - Choose whether you want each person's place of marriage 
printed after the marriage date.

This Surname Only - Choose whether you want to limit the listed persons to those with the
same surname as the progenitor.

This Soundex Only - Choose whether you want to limit the listed persons to those with the
same soundex-encoded surname as the progenitor. This will allow persons with minor 
surname variations to also appear.

New Line Before Spouse - Choose whether you want a new line before each spouse 
and/or marriage shown. The use of a new line helps to set apart the spouse’s information 
when the data    is generated and printed as the Descendancy Report. If you decide to use 
the report’s Output To feature, you may find that the new line for each spouse results in text
formatting inconsistent with your needs, you might want to turn this option off.



Shortcut Menus
A number of functions are available on the Descendancy View via the mouse right-button 
shortcut menus. These of course include the usual text Cut, Copy, Paste, and Delete functions. 
Additionally, the following functions are available.

Size and Position - Remember, Forget or Recall the current View window size and screen 
position. Family Matters will automatically recall the size and position each time the View is 
opened.

Show Group - Causes the Family Group View to display data relevant to this person.

Show Person - Causes the Person View to display data relevant to this person.

Show Family - Causes the Family View to display data relevant to this person.

Show Picture - The Show Picture command causes the Picture View to display the 
pictures linked to the selected person.

Before you print your Descendancy Chart you may choose to edit any of the entries. You are 
free to do that, and your edits will be stored in your database. You may also decide to delete 
some records. To delete a single record, click once in the selection area on the left to mark the 
record, then use your delete key to delete the operation. To delete multiple records, either drag 
the mouse pointer through the selection buttons, or use shift-arrow to select the records. Then 
use your delete key to perform the operation.

Don't hesitate to make a report for Aunt Blanche when she visits. Just link her as the head, and 
Uncle Dick as her spouse. Then print her the Descendancy Report pages to take back home to 
show Uncle Dick and Laura and the family. Descendancy Charts can be made for any person in 
your database, and will be stored for next time.



Event View
The Event View presents a summary listing of all the event records in the database sorted by 
event data. The four columns are Event Date, Event Type (Birth, Marriage, Death, etc.), Full 
Names and birth dates of the person or couple, and place or location of occurrence.    The three 
buttons across the top allow you to quickly seek to the full record of the family or person to 
whom the highlighted event is associated. The associated sort control lets you sort your event 
every which way, to help you determine associations between persons, families, and events in 
your database.

The slider on the Event View can be used to quickly position to help you get the desired record 
displayed.

There is an activation button on the Toolbar, as well as a menu entry under Views.

Action Buttons
The buttons across the top of the Event View allow you access to the Show Object commands 
of Group, Family, and Person, and to print the Event Report, with the current Event View filter 
and sort selections, and to obtain Help. 

Group - This button executes the Show Group command for the person associated with the
selected event. Navigation to any family in the Family Matters database is performed by 
depression of the Group button. The Family Group View will then display the selected 
record. 

Family - This button executes the Show Family command for the person associated with 
the selected event. Navigation to any family in the Family Matters database can be 
performed by depression of the Family button. The Family View will then display the record 
of the selected family.

Person - This button executes the Show Person command for the person associated with 
the selected event. Navigation to any person in the Family Matters database can be 
performed by depression of the Person button. The Person View will then display the record
of the selected person.

Print - Quick-Print the Event report with currently chosen event content and sort. Use the 
Print Toolbar button to preview.

Help - Open this Help topic.

Event Type Filter
This control allows you to filter the types of events included in the display. You can choose All, 
All-Except-Birth, or any single event type. You can also choose from set of event groupings. The
ability to view Event Groupings is a very powerful research feature. Event Groupings that are 
built-in include Birth (with Christening and Baptism), Death (with Burial and Cremation), 
Emigration with Immigration, and LDS events. Also, Family and Person Events may be viewed 
together, or separately. Note than the Place data can be edited when either Birth-only is 
selected, or when a selection that excludes Birth is made.

Sort



The entries on the Event View may be sorted on any one of more than two dozen built-in sets of
sort criteria. The left-most control at the top of the window displays the sort possibilities. The 
default view upon initially opening the view is by Surname, Date, Event, and Place, to be 
consistent with most data shown in Family Matters. To use the sort control, click the button to its
right. The sort criteria list will appear. Choose any you wish. When the resort is complete the 
same record will be highlighted that was selected prior to the sort. Also, the next time you open 
the Event View, it will restore your filter settings.

Surname Filter
This control allows you to filter the surnames displayed. You can choose ALL, or any single 
surname in your database.

Shortcut Menus
A number of functions are available on the Event View via the mouse right-button shortcut 
menus. These of course include the usual text Cut, Copy, Paste, and Delete functions. 
Additionally, the functions of Show Object, copy event, and copy person, depending on the 
specific field which has the focus.

Show Group, Family, Person -  These shortcuts are available when the focus is on an 
appropriate event. Like the action buttons, described above, the Show group command is 
available whether a family of person event has the focus. The Show Family    and Show 
Person shortcuts are only available when a corresponding event type has the focus.

Show Picture - The Show Picture command causes the Picture View to display the 
pictures linked to the selected person.

Copy Person Link – This command copies a link to the person with the focus to the object 
paste buffer. Using the Paste Person Link command on the Group View accomplishes 
linking of this person to other families and persons.

Copy Event – This command copies the event specifics with the focus to the object paste 
buffer. Using the Paste Event command on either the Family, Group, or Person Views 
accomplishes duplication of this event to other families and persons.

Size and Position - Remember, Forget or Recall the current View window size and screen 
position. Family Matters will automatically recall the size and position each time the View is 
opened.



Family List
The Family List presents a summary listing of all the records in the Family Group database 
sorted i in the same manner as on the Group View. The three columns are Primary Person 
Birthdate, Primary Person Full Name, and Spouse Full Name. The slider on the Family List can 
be used to quickly position to help you get the desired record displayed.

Your Family database is sorted by Surname, birth date, first name, formation date of the family, 
and then entry date of the record. The formation date is the earliest date of events like marriage,
engagement, and first child. Through the deletion, and modification of records representing 
events and children, the Family database sort order may become other than desired. The Sort 
Family Records Tool reorders the Family database according the current dates.

Action Buttons
The buttons across the top of the Family List allow you access to the Show Object commands of
Group and Family, to print the Group Report, and to obtain Help. 

Print - Quick-Print the Group report for the with currently chosen Family Group.

Family - This button executes the Show Family command for the family currently with the 
focus. Navigation to any family in the Family Matters database can be performed by 
depression of the Family button. The Family View will then display the record of the 
selected family. 

Group - This button executes the Show Group command for the family currently with the 
focus. Navigation to any family in the Family Matters database is performed by depression 
of the Group button. The Family Group View will then display the selected record. 

Help - Open this Help topic.

Shortcut Menus
The functions available on the Family List via the mouse right-button shortcut menus duplicate 
the functions available with the Action buttons.

Show Group, Family - Like the action buttons, described above, the Show Group and 
Show Family commands cause the Group View and the Family View to display the selected
family

Size and Position - Remember, Forget or Recall the current View window size and screen 
position. Family Matters will automatically recall the size and position each time the View is 
opened.

Print - Quick-Print the Group report for the with currently chosen Family.

Output To - Outputs the Family List to one of a number of file formats including HTML, 
RTF,    TXT, and others.



Family View
The Family View presents a summary listing of all the records in the database sorted in the 
same manner as on the Group View. The database is sorted by Surname, birth date, first name,
formation date of the family, and then entry date of the record. The formation date is the earliest 
date of events like marriage, engagement, and first child. Through the addition, deletion, and 
modification of records representing events and children, the Family database sort order may 
become other than desired. The Sort Family Records Tool reorders the Family database 
according the current dates.

The Go To Home Toolbar button causes the Family View to seek directly to the family you have 
previously designated as ‘Home’; perhaps your own family, or your parents' family.

Action Buttons
The buttons across the top of the Family View allow you access to the Quick-Finder, the Show 
Group command, print the Group Report, and to obtain Help. 

Quick-Finder - The Family Quick-Finder lists all the families in your database, allowing you
to choose the name of the family    you may next want to go to. Selection causes the 
immediate display of the selected family, or you may hit the Enter key while the selection is 
highlighted.

Back - Takes you back to every record on the Family View that you have viewed since 
opening the view.

Print - Quick-Print the Group report for the with currently chosen Family Group.

Group - This button executes the Show Group command for the family currently with the 
focus. Navigation to any family in the Family Matters database is performed by depression 
of the Group button. The Family Group View will then display the selected record. 

Help - Open this Help topic.

Data Fields
The Family View shows the data associated with this family. The first row is the Hyper-Link to 
this family in your web site (if you've generated one with the Web Dialog), followed by a 
Exclude/Include choice. You can use this text by pasting it into another web page, to link to this 
family on the web. Also, you can choose to have this family included or excluded from your web 
site. Leave this at include until your are experienced with web site generation. The last section 
is your notes on this family.

Shortcut Menus
A number of functions are available on the Family View via the mouse right-button shortcut 
menus. These of course include the usual text Cut, Copy, Paste, and Delete functions. 
Additionally, the functions of go to, show group, show person, and copy person, depending on 
the specific field which has the focus, as well as the copying, pasting, and deleting of events.

Go To -  This shortcut provides, like the corresponding buttons on the Toolbar and Records 
menu, access to the next, previous, first last, and new records.



Size and Position - Remember, Forget or Recall the current View window size and screen 
position. Family Matters will automatically recall the size and position each time the View is 
opened.

Copy Person Link - The Copy Person Link function allows you to copy a link to the person 
who currently has the focus. You will then be able to paste that person link into another 
family situation, thus causing Family Matters to connect the appropriate relationships.

Show Group - Like the action button, the Show Group command cause the Group View to 
display the selected family.

Show Person - Like the action button, the Show Person command cause the Person View 
to display the selected person.

Show Picture - The Show Picture command causes the Picture View to display the 
pictures linked to the selected person.

Print - Quick-Print the Group report for the with currently chosen Family.

Copy Event - The Copy Event function allows you to copy the event which currently has 
the focus. You will then be able to paste that event into another event subform, assuming 
that it meets certain compatibility tests.

Paste Event - Events already in the database can be linked to other persons and families 
with the assistance of the Event Copy and Paste functions. Copy the event person from any
view. Next, choose Paste Event, and you will be prompted to verify your choice. Choose OK
to confirm.

Delete Event - The Delete function allows deletion of all traces of an event from your 
database. 



Group View
The Family Group View displays one full family at a time. You view the data for both parents, 
their parents names, and a brief summary of all their children. Using the Family Group View, you
can view, add, delete, link, and unlink people and whole families.

Your Family database is sorted by Surname, birth date, first name, formation date of the family, 
and then entry date of the record. The formation date is the earliest date of events like marriage,
engagement, and birth of the first child. Through the addition, deletion, and modification of 
records representing events and children, the Family database sort order may become other 
than desired. The Sort Family Records Tool reorders the Family database according the current 
dates.

Primary and Spouse
Both the Primary and Spouse sections are set up for (in order) first name, surname, 
relationship, male/female. Next is Father's birth date, Father's first name, Father's surname, 
Mother's birth date, Mother's first name, and Mother's surname. For the parents, you will have to
enter data in the name field to create a person record before you will be able to enter a parent. 
birth date. 

The line labeled Birth is for the birth event; date of birth and place of birth, followed by the 
events subform. The events subform can display as many events as you like for each person. 
The only limitation is that there be only one Birth and one Death event for each person. You can 
copy, paste, and delete events with the right-button shortcut menus.

Family Events
Like the events subform section within the Primary and Spouse display areas, this section 
displays an unlimited number of events that you have associated with this family. There is no 
limit to the number of times this family married, divorced, was documented in the census, or had
any other event occur. You can copy, paste, and delete events with the right-button shortcut 
menus.

Children
The Children section has space for as many children as you can fit on your screen, with no limit 
per family or person. You may scroll the children portion of the display, to show more. For each 
child you may enter sibling number (optional), birth date, first name, surname, place of birth, and
sex. The child’s surname will be automatically filled in for you, based upon the surname of the 
male parent, and the surname used for subsequent children.

The Family Group Report will print as many children as you have entered for a family. You can 
make room for more children to be displayed by increasing the length of the displayed view 
window, or by decreasing the scale factor on the Options Dialog. There will always be a last 
child record displayed. This is not a blank record. It is known as the new record. It does not 
become an actual record until you enter data into it. The children will initially be displayed in the 
order you have entered them. 

Primary Notes, Spouse Notes, and Family Notes
The Notes sections are for your free text. You may have up to 2-billion characters of text. Use 
this area for nicknames, Social Security number, address, high school, college, profession, 
employment, questionable data, current data collection efforts, medical history, cause of death, 



or just an interesting story from Aunt Catherine. Use the Family Notes field for information about
the union of the Primary and Spouse, like things relating to marriage or divorce, or perhaps a 
census.

Soundex
Soundex is a system whereby surnames of similar sound or spelling result is similar codes, to 
facilitate searching and indexing. The soundex values for the Primary and Spouse surnames 
are shown above the respective surnames on this view. Additional support for the Soundex 
system is provided by the Soundex Calculator, available from the Tools menu.

Navigation
Clicking on the button next to a parent's or child's name will take you to the family record of that 
family members. Or, if no family record is found, Family Matters will prompt you to allow it to 
create a family record for the referenced parent or child. Family Matters will then display the 
known information from the current family in the new family. The new record is then 
automatically placed in the correct order in the database. Note that the record data displayed is 
the same; it is just displayed from the point of view of a different family member.

Clicking on the button to the left of the Primary or Spouse name will take you to any other family
that person is a member of, as a primary or a spouse, should there have been more than one 
marriage or family for that person. The button will be inactive if the person has only this one 
family in the database.

Family records can be accessed sequentially through the use of the Go To buttons on the 
Toolbar and the Go To selections on the Records Menu. In addition, one family per database file
can be designated as ‘Home’. You might choose this to be you and your spouse (if you have 
your own family), or you and your parents and siblings. This would be the family that you would 
most often like to seek directly to. This function is available to both the Group View and the 
Family View.

Browsing
You may browse you database in a number of ways. The next or previous family may be 
accessed by use of either the Page Up and Page Down Keys, or the corresponding buttons on 
the Toolbar. Alternatively, you may use lineage browsing. A click on the button next to name of a 
child or parent will bring you to that record. By repeating this action, you may traverse up and 
down the branches of you family tree. Or, the Family, Person, or Event Views can be used to 
scroll through the items, then immediately access that person or family via a Group, Family, or 
Person via the corresponding show command.

Group View Action Buttons
The buttons across the top of the Family Group View allow you use the family and person 
Quick-Finders, Swap the displayed primary and spouse persons, and obtain help. 

Quick-Finder - The Group View Quick-Finder is made up of two selection boxes, which list 
all the families and persons in your database, allowing you to choose the name of the family
or person you may next want to go to. Selection causes immediate display of the selected 
family or person, or you may hit the Enter key while the Quick-Finder selection is 
highlighted.

Back - Takes you back to every record on the Family Group View that you have viewed 
since opening the view.



Swap - The persons displayed as Primary and Spouse may be interchanged by the use of 
the Swap button.

Print - Quick-Print the Family Group Report just for the current family.

Help - Open this Help topic.

Shortcut Menus
A number of functions are available on the Family Group View via the mouse right-button 
shortcut menus. These of course include the usual text Cut, Copy, Paste, and Delete functions. 
Additionally, the following functions are available, depending on the specific field which has the 
focus: go to, create new families for either the primary or spouse, copy, paste and unlink 
persons and/or events, and delete items from the database          .

Go To -  This shortcut provides, like the corresponding buttons on the Toolbar and Records 
menu, access to the next, previous, first last, and new records.

Size and Position - Remember, Forget or Recall the current View window size and screen 
position. Family Matters will automatically recall the size and position each time the View is 
opened.

Create Family - The Create function allows the simple creation of a new family for either 
the Primary or the Spouse. You will be prompted to confirm your action. Suppose that 
someone is already in your database (Grandma Bianco), and you wish to set up a new 
family record, but with her second husband. Use Create to create a new family with 
Grandma Bianco as the primary in the new record. Note that her parent’s names appear 
with her as soon as the new Family Group is displayed. Next, assuming that her second 
husband is not yet in the database (he's not your Grandpa, right?), type his information into 
the spouse area.

Copy Person Link - The Copy Person Link function allows you to copy a link to the person 
who currently has the focus. You will then be able to paste that person link into another 
family situation, thus causing Family Matters to connect the appropriate relationships.

What if Grandma Bianco had children with the second husband, and you currently have 
them as children of your Grandpa? No problem. Just Copy then Paste (see below) the link 
for each child to the newly-formed family. When you do this, Family Matters will also unlink 
them from your Grandpa. Done. You have just pruned and grafted a part of your family tree.

Paste Person Link - Persons already in the database can be linked to others (as spouse, 
child, or parent) with the assistance of the Person Copy and Paste Link    functions. Copy 
the person link from any view. Next, choose Paste Person Link, and you will be prompted to
verify your choice. Choose OK to confirm.

Unlink Person - Likewise, persons may be unlinked or deleted. Choose Unlink Person. You
will be prompted to verify your choice. Choose OK to confirm. If the person you are 
operating on has other linkages in the database that are not currently displayed, an 
additional confirmation will be requested, with the number and types of linkages (spouse, 
father, mother). You can set Options to cause the second confirmation to displayed 
regardless.



Delete Person - The Delete function allows deletion of all traces of a person from your 
database. Should the person have links within the database (such as spouse, father, etc.) 
the types and number will be displayed to you for confirmation prior to the actual delete 
taking place. You can set Options to cause this second confirmation to always be displayed.
Note that it is possible to leave families without either a primary or a spouse by using 
delete, though there may be children of the family. Families can themselves be deleted 
whenever you choose.

Delete Family - The family record you are viewing can be deleted, and the persons in it 
unlinked. Choose Delete Family when a family-oriented field has the focus. Note that this 
action will not delete anyone from the database, just the family links. It does, however, 
remove the family notes, and events.

Copy Event - The Copy Event function allows you to copy the event which currently has 
the focus. You will then be able to paste that event into another event subform, assuming 
that it meets certain compatibility tests.

Paste Event - Events already in the database can be linked to other persons and families 
with the assistance of the Event Copy and Paste functions. Copy the event person from any
view. Next, choose Paste Event, and you will be prompted to verify your choice. Choose OK
to confirm.

Delete Event - The Delete function allows deletion of all traces of an event from your 
database. 

Multiuser Considerations
If you are in a multiuser environment, be aware that linking, unlinking, adding and deleting can 
modify the records of more persons than just the ones you are physically viewing. Multiuser 
Considerations has more information on this topic.

View Display
Note:    Family Matters allows you to set the vertical scaling and font size of the data views. The 
Family Group View displays well on a 1024x768 resolution display, at 96 logical dots per inch 
(dpi), using a 100% scaling and 10 point type. The Options Dialog allows the scaling and type 
size to be set to values of your liking. If you have a VGA (640x480) or a SVGA (800x600) 
display, Family Matters has initially set the Options values accordingly. Settings of other than 
100% and 10 points may slow the initial view display on some computers.



Pedigree View
Each Pedigree Chart page represents a single record in the Pedigree database. You will 
probably want to begin the first page with either you, your spouse, or your child. Once you link 
the root person on a page, Family Matters will then automatically fill in your parents, 
grandparents, and great-grandparents on that page. You can then use Extend or Extend All to 
have Family Matters generate an unlimited number of connected pages.

The Pedigree View can be sized to fit your computer screen. Use the Options Dialog to set the 
displayed font size, and your choice of vertical scaling value. Also, you can allocate as much 
space as you like for the date field. Next, horizontally size the window and the fields will resize 
to fit the available space. You can then have Family Matters remember the windows size by use 
of the View Menu. You can also choose to set the vertical scaling to Auto, which will resize the 
view’s objects whenever you vertically resize the window it’s displayed in. The default setting is 
Auto.

The small F and M buttons on the right facilitate navigation to other Pedigree Charts that extend
from the current chart. If the button isn’t enabled (it’s grayed), it’s because the person of 
interest doesn’t have parents in the database. When you click one of the enabled buttons, you 
will be taken to the chart of that parent (Father or Mother). If that chart doesn’t exist, but the 
next person does, Family Matters will ask you if you would like to create that chart. Newly 
created charts like that (and also by using Extend and Extend All) will have the same Title as the
chart they are extended from, the same sequence number, and will be given the Sub-title 
‘Mother of John Conrad Miller’, for instance, if it was the F button you clicked on John Conrad 
Miller. You can of course edit these to anything you wish.

There can be as many of these pages in your Pedigree database as you like. They will be 
sequentially viewed in the order determined by your entry into the sequence number field. 
Pedigree Reports may be printed, and will look exactly like the screen presentation, except that 
the sequence number and controls are suppressed from printing, and the background will be 
white.

Two fields of title text can be entered on each page. The second field (the sub-title) accepts the 
enter key as termination of its first line and the start of the second. An example of the Pedigree 
title text you might choose is:

The Pedigree of John Conrad Miller
John Miller and His Parents, Grandparents, and Great Grandparents
Chart Number One of Sixteen

The second page could be made nearly identical, such as:

The Pedigree of John Conrad Miller
Great Great Grandfather John Miller and His Ancestors
Chart Number Two of Sixteen

Linking



The drop-down menus just above the Primary and Spouse are used to place links to persons in 
the Pedigree database. If there isn't a name there yet, there will be an empty rectangle in its 
place. Family Matters will verify the validity of the action, then link the person in the desired role.
The respective Unlink button is used to reverse these actions. The Spouse field will be 
automatically linked, if the new Primary has exactly one Spouse in the database.

The birth and death fields on the Pedigree View can contain a summary of the data you keep for
the Family Group View. Family Matters initializes the Pedigree fields when an person first 
appears on a Pedigree, and then updates it whenever the birth or death place data changes. 
These conditions are important to understand when and why the data in the birth-place and 
death-place fields change. 

Pedigree View Action Buttons
The buttons across the top of the Pedigree View allow you to go Back to previously viewed 
records, Quick-Print the current Pedigree Report, delete the current pedigree chart from the 
database, Requery the database, add Pedigree charts that Extend from the current chart, add 
Pedigree charts that Extend from All charts, and obtain help.

Quick-Finder - The Pedigree View Quick-Finder lists all the pedigrees you’ve created in 
your database, allowing you to choose the one you may next want to go to. Selection 
causes immediate display of the selected pedigree, or you may hit the Enter key while the 
Quick-Finder selection is highlighted.

Back - Takes you back to every record on the Pedigree View that you have viewed since 
opening the view.

Print - Quick-Print the Pedigree Report for the current record.

Delete - Deletes the current Pedigree Chart from the database.

Requery - Re-displays the current Pedigree Chart, with the latest data from the database.

Extend - Prompts you to add any needed Pedigree Charts that extend from the current 
chart.

Extend All - Prompts you to add any needed Pedigree Charts that extend from any and all 
other Pedigree Charts in the database.

Help - Opens this topic in the Help file.

Shortcut Menus
A number of functions are available on the Pedigree View via the mouse right-button shortcut 
menus. These of course include the usual text Cut, Copy, Paste, and Delete functions. 
Additionally, the following functions of go to ,copy person, show person, and show group are 
available, depending on the specific field which has the focus.

Go To -  This shortcut provides, like the corresponding buttons on the Toolbar and Records 
menu, access to the next, previous, first last, and new records.

Size and Position - Remember, Forget or Recall the current View window size and screen 
position. Family Matters will automatically recall the size and position each time the View is 



opened.

Copy Person Link - The Copy Person Link function allows you to copy a link to the person 
who currently has the focus. You will then be able to paste that person link into another 
family situation, thus causing Family Matters to connect the appropriate relationships.

Show Group - Causes the Family Group View to display data relevant to this person.

Show Person - Causes the Person View to display data relevant to this person.

Show Picture - The Show Picture command causes the Picture View to display the 
pictures linked to the selected person.

Don't hesitate to make a report for Aunt Maria when she visits. Just link her as the root, and 
Uncle Andy as her spouse, on a new page. Then print her a page to take back home to show 
Uncle Andy and the family.



Person List
The Person List presents a listing of all the person records in the database sorted by    surname 
and birthdate. The data displayed comprises full name, birth date, and relationship. There is a 
Person List activation button on the Toolbar, as well as a menu entry under Views. The Person 
List slider can be used to quickly position to help you get to the desired person.

Action Buttons
The buttons across the top of the Person List allow you access to the Show Group command, 
Quick-Print a Person Report, delete the current person, and obtain help.

Group - This button executes the Show Group command for this person. The Family Group
View will then display the selected record. Clicking on the Group button will cause the 
Family Group View display with the desired person, as will the right-button Show Group 
command.

Print- Quick-Print the Person Report just for the current person.

Delete - The Delete Person function allows deletion of all traces of an person from your 
database. Should the person have links within the database (such as spouse, father, etc.) 
the types and number will be displayed to you for confirmation prior to the actual delete 
taking place. Note that it is possible to leave families without either a primary or a spouse 
by using delete, though there may be children of the family. Families can themselves be 
deleted when you choose.

Help - Opens this topic in the Help file.

Shortcut Menus
A number of functions are available on the Person List via the mouse right-button shortcut 
menus. These of course include the usual text Copy function. Additionally, the following 
functions are available, depending on the specific field which has the focus.

Copy Person Link - The Copy Person Link function allows you to copy a link to the person 
who currently has the focus. You will then be able to paste that person link into another 
family situation, thus causing Family Matters to connect the appropriate family relationships.

Delete Person - Like the action button, the Delete Person shortcut function allows deletion 
of all traces of an person from your database. 

Show Group - Causes the Family Group View to display data relevant to this person.

Show Person - Causes the Person View to display data relevant to this person.

Show Picture - The Show Picture command causes the Picture View to display the 
pictures linked to the selected person.

Size and Position - Remember, Forget or Recall the current View window size and screen 
position. Family Matters will automatically recall the size and position each time the View is 
opened.



Print - Quick-Print the Person Report just for the current person.

Output To - Outputs the Person List to one of a number of file formats including HTML, 
RTF, TXT, and others.

Multiuser Considerations
If you are in a multiuser environment, be aware that deleting can modify the records of many 
more persons than just the ones you are physically viewing. Multiuser Considerations has more 
information on this topic.



Person View
The Person View presents a listing of all the person records in the database sorted by person 
surname and birthdate. There is a Person View activation button on the Toolbar, as well as a 
menu entry under Views.

Action Buttons
The buttons across the top of the Person View allow you access to quickly access records, the 
Show Group command, and to print the Person Report, and obtain Help. 

Quick-Finder - The Quick-Finder lists all the persons in your database, allowing you to 
choose the name you may next want to go to. Selection causes the immediate display of 
the selected person, or you may hit the Enter key while the selection is highlighted.

Back - Step back through all the Person View records displayed since it was opened.

Group - This button executes the Show Group command for this person. The Family Group
View will then display the selected record. The right-button shortcut of Show Sroup 
executes the same commend.

Print - Quick-Print the Person Report just for the current person.

Delete - The Delete Person function allows deletion of all traces of an person from your 
database. Should the person have links within the database (such as spouse, father, etc.) 
the types and number will be displayed to you for confirmation prior to the actual delete 
taking place. Note that it is possible to leave families without either a primary or a spouse 
by using delete, though there may be children of the family. Families can themselves be 
deleted when you choose.

Help - Opens this topic in the Help file.

Data Fields
The Person View shows all the data associated with this person. The top row is the first name 
followed by the surname. The second row is this person's relationship to you, followed by their 
sex. The third row is the Hyper-Link to this person in your web site (if you've generated one with 
the Web Dialog), followed by a Default/Exclude/Include choice. You can use this text by pasting 
it into another web page, to link to this person on the web. Also, you can choose to have this 
person definitely included or excluded from your web site, or just let the living/died filter on the 
Web Dialog choose. Leave this at default until your are experienced with web site generation.

The fifth row begins the data you know about the events of this person's life. It is for birth 
information (date and place). The next section is a scrollable view of all the other events in this 
person's life. Finally, the names of this persons parents will appear, followed by your notes on 
this person.

Shortcut Menus
A number of functions are available on the Person View via the mouse right-button shortcut 
menus. These of course include the usual text Copy function. Additionally, the following 
functions of go to, copy and delete person, and event management are available, depending on 
the specific field which has the focus.



Go To -  This shortcut provides, like the corresponding buttons on the Toolbar and Records 
menu, access to the next, previous, first last, and new records.

Size and Position - Remember, Forget or Recall the current View window size and screen 
position. Family Matters will automatically recall the size and position each time the View is 
opened.

Copy Person Link - The Copy Person Link function allows you to copy a link to the person 
who currently has the focus. You will then be able to paste that person link into another 
family situation, thus causing Family Matters to connect the appropriate family relationships.

Delete Person - Like the action button, the Delete Person shortcut function allows deletion 
of all traces of an person from your database. 

Show Group - Causes the Family Group View to display data relevant to this person.

Copy Event - The Copy Event function allows you to copy the event which currently has 
the focus. You will then be able to paste that event into another event subform, assuming 
that it meets certain compatibility tests.

Paste Event - Events already in the database can be linked to other persons and families 
with the assistance of the Event Copy and Paste functions. Copy the event person from any
view. Next, choose Paste Event, and you will be prompted to verify your choice. Choose OK
to confirm.

Delete Event - The Delete function allows deletion of all traces of an event from your 
database. 

Create Family - The Create Family action allows the creation of a family for the displayed 
person. You will be prompted to confirm your action. The Family Group View will then open, 
displaying your new Family Group.

Multiuser Considerations
If you are in a multiuser environment, be aware that deleting can modify the records of many 
more persons than just the ones you are physically viewing. Multiuser Considerations has more 
information on this topic.



Picture View
The Picture View presents all the picture records in the database sorted by picture title and 
date. There is a Picture View activation button on the Toolbar, as well as a menu entry under 
Views.

There are four tabs on the Picture View: Picture, Data and Notes, Database Links, and Options. 
Using the Picture tab you can view the picture you have linked, any file access errors, or a 
picture embedded from a database upgrade from a previous version. The Data and Notes is for 
storage of information about the picture. Database Links is where you manage the links 
between persons and pictures. Finally, Options is for optional settings.

You can limit the pictures displayed to those linked to a particular person, or to those linked to 
no persons. When other than all pictures are being displayed, the identifier “(Filtered)“ appears 
on the Record control at the bottom edge of the Picture View.

Action Buttons
The buttons across the top of the Picture View allow you access to quickly access records, print 
the Picture Report, and obtain Help. 

Quick-Finder - The Quick-Finder selection box lists all the pictures in your database, 
allowing you to choose the picture you may next want to view. Selection causes the 
immediate display of the selected picture, or you may hit the Enter key while the selection is
highlighted.

Back - Step back through all the Picture View records displayed since it was opened.

Print - Quick-Print the Picture Report just for the current person.

Delete - The Delete Picture function allows deletion of all traces of an picture from your 
database. Should the picture have links to persons within the database, the number will be 
displayed to you for confirmation prior to the actual delete taking place.

Help - Opens this topic in the Help file.

Data Fields
The Picture Tab shows you the picture, or any errors Family Matters had in accessing the 
picture in your computer. If you use your database in another computer, without the pictures on 
its disk, you will generally see the “File Not Found” message. However, all other picture-related 
functions will still be available.

The Data and Notes Tab is for the data you’ve stored about the picture. The fields are as 
follows:

Name - This is for the name of the picture. Generally this will be a one-line name. If you use
multiple lines, it is the first line that will be used for the Quick-Finder. Hence, this field 
should be entered for every picture. This field will appear centered as a page header on the
Picture Report.

Describe - This is for a description of the of the picture. Here you can put the multiple lines 



that you may have considered in the Name field. This field will appear centered just below 
the Name field on the Picture Report, at a somewhat smaller font.

Date - This is for the date the picture was taken. This field will behave the same as any data
field in Family Matters. The date will appear centered just below the picture on the Picture 
Report, at the same font size as the description.

Location - This is for the location at which the picture was taken, if you know it. The 
location will appear centered just below the date on the Picture Report, at the same font 
size as the date.

Occasion - This is for the occasion for which the picture was taken, if any. The occasion 
will appear centered just below the location on the Picture Report, at the same font size as 
the location.

Path - This is for where the picture is stored on your computer’s disk. The Path button can 
be used to browse for the file. Picture files will display quickest if stored as bit-map (bmp) 
file. Resolution of 150 dpi is sufficient for screen display, though you may want to use higher
for printing.

Notes - Located below the Path field, the Notes field is for information about the picture that
does not seem to fit in any of the above fields. If the picture is a group shot for instance, you
perhaps could use this filed for a front row, middle row, back row sort of dialog.

The Database Links Tab is where you will mange the connections between persons and 
pictures.

The large list in the center of this page is organized similarly to the Person List View. The 
contents are full name, birth date, and relationship. You will use the Person Selection 
control to limit the display of person relative to your pictures. Of particular interest in this 
control are the “Link to Picture” and “Unlink from Picture” right-button shortcuts available 
when this control has the focus. These are the actions available to you manages the 
database connections between persons and pictures.

Picture Selection - This control sets the pictures that are currently displayed. If other than 
“Show all pictures” is selected, the identifier “(Filtered)”    is displayed at the bottom edge of
the Picture View. Other selections possible are to “Show only pictures linked to this 
person”, and to “Show pictures not linked to any person”.

Person Selection - This control sets the persons that are currently displayed. Selections 
possible are to “List all persons”, “List only persons linked to this picture”, “List only 
persons linked to any picture”, and to “List persons NOT linked to any picture”.

The Options Tab provides the ability to choose how the picture is viewed.

The Report Picture Size Mode drop-down menu is where you can set the size of the 
picture as it will be printed on the Picture Report. You can set the size of the printed picture,
or choose to print it at its actual size, limited by the report itself.

The Preview Picture Report button brings up the Picture Report in preview mode.



The View Picture Size Mode drop-down menu is where you can set the manner that the 
picture is shown on the Picture View. On Clip, it will show the picture actual size, even if it 
doesn’t fit the window borders. On stretch, it will size the picture to fit the borders, even if it 
means distorting the picture. On zoom, it will size the picture the largest it can to fit the 
border without distortion.

Shortcut Menus
A number of functions are available on the Picture View via the mouse right-button shortcut 
menus. These of course include the usual text functions. Additionally, the following functions are
available, depending on the specific field which has the focus.

Go To -    This shortcut provides, like the corresponding buttons on the Toolbar and Records
menu, access to the next, previous, first last, and new records.

Size and Position - Remember, Forget or Recall the current View window size and screen 
position. Family Matters will automatically recall the size and position each time the View is 
opened.

Show Group, Person, Family - Available on the Person List, causes the various Views to 
appear, to display data relevant to this person.

Show Picture - The Show Picture command causes the Picture View to display only the 
pictures linked to the selected person.

Link to Picture - This command causes the selected person to be linked to the current 
picture.    A person can be linked to an unlimited number of pictures.

Unlink From Picture - This command causes the selected person to be unlinked from the 
current picture.



Repository View
Repositories are those places like the National Archives, a particular Church in Europe, and the 
local Department of Health where the primary source evidence of your ancestors rests. Maintain
postal addresses, e-mail addresses, and Internet URLs in this database. Keep notes about your
successes, failures, progress or even driving directions for each repository.    There is a 
corresponding Repository Report.

Action Buttons
The buttons across the top of the Repository View allow you to use the Quick-Finder to access 
records, to print the Repository Report, and obtain Help. 

Quick-Finder - The Repository Quick-Finder lists the names of all the repositories in your 
database, allows you to choose the repository you next want to view. Selection causes the 
view to go directly there, or you may hit the Enter key while the selection is highlighted.

Back Button - Step back through all the Repository records displayed since the view was 
opened.

Print - Quick-Print the Repository Report for the current record.

Delete Button - Delete the currently displayed record.

Help - Opens this topic in the Help file.

Data Fields
The data fields visible on the Repository View include its name, address, phone number, e-mail 
address, World Wide Web URL, and your notes about the repository.

Go To -  This shortcut provides, like the corresponding buttons on the Toolbar and Records 
menu, access to the next, previous, first last, and new records.

Size and Position - Remember, Forget or Recall the current View window size and screen 
position. Family Matters will automatically recall the size and position each time the View is 
opened.

Name - A name of this record. This is the text that is used for the Selection Box, and might 
be the first line in a mailing address.

Address - These lines represent the postal address.

Phone - The telephone number of the repository.

E-Mail - The e-mail address of the repository, if they have one.

Web URL - The World Wide Web URL of the repository, if they have one.

Notes - The notes section is where you can keep contact information relating to the 
repository. Maybe driving directions, or even information about a clerk that has helped you. 
This view section can store over 2-billion characters.



Shortcut Menus
A number of functions are available on the Repository View via the mouse right-button shortcut 
menus. These of course include the usual text Cut, Copy, Paste, and Delete functions. 
Additionally, the functions of go to, go to repository, delete, and print, depending on the specific 
field which has the focus.

Go To -  This shortcut provides, like the corresponding buttons on the Toolbar and Records 
menu, access to the next, previous, first last, and new records.

Delete - Like the Delete action button, this function causes the deletion of the current 
Repository.

Print - Like the Print action button, this function causes the Quick-Print of the current 
Repository.



Source View
The Source View provides you access to a source database. Source data is that data which you
research has unearthed, and upon which you family members and lineage is based. You are 
also able to keep notes about the data, which could include your thoughts about the relative 
accuracy of the data, and the extent to which you have used it. The Source and Repository 
databases are linked, in that the Source Data is held at the specified Repository. There is a 
corresponding Source Report.

Action Buttons
The buttons across the top of the Source View allow you to use the Quick-Finder to access 
records, to delete records, to print the Source Report, and to obtain Help. 

Quick-Finder - The Source Quick-Finder lists the name of all the sources in your database,
allows you to choose the source you next want to view. Selection causes the view to go 
directly there, or you may hit the Enter key while the selection is highlighted.

Back Button - Step back through all the Source records displayed since the view was 
opened.

Print - Quick-Print the Source Report for the current record.

Delete Button - Delete the currently displayed record.

Help - Opens this topic in the Help file.

Data Fields
The data fields visible on the Source View include its title, publication, repository it is kept in, 
location of this source within the repository, the source data itself, and your notes about the 
source. There are three tabbed pages on the Source View, names Source, data, and notes.

The Source Tab is where you can keep the actual content from the source. This view section 
can store over 2-billion characters.

The Data Tab is for the data you’ve stored about the source. The fields are as follows:

Full Title - A full name of this record.

Short Title - An abbreviated name of this record. This is the text that is used for the 
Selection Box, and the records will be sorted by use of this text. You might use the form 
‘Event_Type; Surname’ for this filed so that all your birth, burial, marriage, etc, records are 
sorted together, for instance.

Publication - Information relating to the publication of the data.

Repository - The name of the repository at which the source data is archived. The 
available entries here are from the Repositories you have entered.

Location - The location of this source data in the repository. This could be a library Call 
Number, or perhaps the grave location information in a cemetery.



Source Data Content - The Source Data section is where you can keep the actual content 
from the source. This view section can store over 2-billion characters.

The Notes Tab is where you can keep information relating to the source. This view section can 
also store over 2-billion characters.

Shortcut Menus
A number of functions are available on the Source View via the mouse right-button shortcut 
menus. These of course include the usual text Cut, Copy, Paste, and Delete functions. 
Additionally, the functions of go to, go to record, delete, and print, depending on the specific field
which has the focus.

Go To -  This shortcut provides, like the corresponding buttons on the Toolbar and Records 
menu, access to the next, previous, first last, and new records.

Size and Position - Remember, Forget or Recall the current View window size and screen 
position. Family Matters will automatically recall the size and position each time the View is 
opened.

Show Repository - Causes the Repository View to display data relevant to this source.

Delete - Like the Delete action button, this function causes the deletion of the current 
Source.

Print - Like the Print action button, this function causes the Quick-Print of the current 
Source.



Genealogical Tools
The Genealogical Tools in Family Matters are available from the Tools menu. The following tool 
topics are addressed here:

· Date Calculator
· Relationship Calculator
· Sort Family Records
· Soundex Calculator
· Statistics Tool

Date Calculator
The Date Calculator Tools presents an Initial Date, an Elapsed Calendar Time, and a Final Date.
Using any two, it will compute the third. This is very useful if you have the date someone died 
(perhaps from a death certificate or a tombstone inscription), and their age at death. Using the 
Date Calculator, you can compute their date of birth. The Date Calculator assumes that there 
was not an intervening calendar change, so enter both dates as either Old Style or both as New 
Style (without the OS or NS).

Be aware that this method of birth date determination is inexact, because you are depending on 
data from the age computation done at the time of death or burial. Firstly, the exact birth date 
may not have been exactly known. Second, the person determining the age at death probably 
did not have a computer at hand. Third, the number of days in a month is not a constant. As a 
very simple example, a month and a day from Feb 28 yields different results depending on 
whether the months or days are added first. In Family Matters, all calculation (either forwards of 
backwards) are done year first, month second, days last. Also, if the calculation period includes 
a calendar change, your ancestor may have been born perhaps eleven days earlier.

Event Dictionary
This dialog allows the entry and maintenance of events supported in the database.    Family 
Matters supports all the events and roles defined in GEDCOM Version 5.5, as well as all 
previous versions of the GEDCOM standard. These built-in events cannot be deleted or 
modified. The Stats button allows you to check the quantity of any type of event in use.

The Event Dictionary is activated by the selection of a menu selection under Tools. User-defined
entries may be added, deleted and edited. Changes made will be visible the next time a view 
utilizing events is displaying.

You can also use the Event Dictionary to determine which events in your database will be output
to your genealogical web site. By default, Birth, Baptism, Christening and Marriage are, but you 
can add to them, or remove some; whatever you choose.

When defining user events, certain guidelines should be followed. You should indicate for each 
event whether it applies to families, persons, or to both. Choose a meaningful name for your 
event, that is not a duplicate of an existing event. For future GEDCOM import or export 
capability, you should choose a GEDCOM ‘tag’. These are usually four characters, plus a 
beginning underscore character (_). Family Matters will prevent duplication of GEDCOM tags.

Upon deletion of a user-defined event, Family Matters will check to see if it is currently in use. If 
it is, you will have the option of automatically deleting all such events, or canceling the 



operation. If events exist of the type that you wish to delete, but you don’t want to automatically 
delete them all, use the Event View to find all instances of use of the event in question. You can 
then seek to the either the Family Group View, the Person View or Family View to delete or 
change the events in question.

Note that user-defined events and tags will only transfer properly to/from another program if it 
also supports user-defined events, and its tags are set to the same value.

Relationship Calculator
The Relationship Calculator Tool allows you to set every persons relationship to you (or to 
anyone you wish). Using the first button, you can clear the relationship field of every person in 
the database. Using the second button, you can set the Relationship Basis. This is the person 
from whom all relationship calculations will be made. This could be you. Or it could be your 
Fourteenth Great Grandfather.

You may want to keep both yours and your spouse’s genealogy together in one file. First, clear 
all the relationship fields. Next designate your spouse as the Relationship Basis. Then compute 
all. Next, designate yourself as the Basis. Again, compute all. Now all the relationship fields will 
indicate that persons relationship to you, or to your spouse. (Should anyone be related to both 
of you, the relationship will be overwritten during the second pass.)

Persons related to you are descended from one or more of the people you are descended from 
(like parents, and grandparents), or directly from you. The action of the Relationship Tool is to 
move up the ancestral tree from each person in question, until a common ancestor (or two) is 
reached. For instance, a person descended from your Grandparents, in your generation, is your 
First Cousin. Once located, the search does not continue to look for lesser relationships. Also, 
Half relationships are identified. In the above example, a person descended from only one 
Grandparent is your Half First Cousin.

Sort Family Records
Your Family database is sorted by Primary surname, birth date, first name, formation date of the
family, and then entry date of the record into your database . The formation date is the earliest 
date of events like marriage, engagement, and first child. Through the deletion and modification 
of records representing events and children, the family database sort order may become other 
than desired. The use (and reuse) of this tool reorders the family database according the current
dates.

Soundex Calculator
The Soundex system is a means of coding surnames such that the soundex codes of similar-
sounding surnames will yield identical results. There are census records that are indexed using 
soundex codes. 

For many U.S. surnames, this works well. For instance, the soundex code for Nicklas is ‘N 242’.
The vowels are ignored, and the ‘ck’ pairing is treated as one consonant. This means that N 
242 would also find an early Niklas spelling. Note that since the c and the s potentially could 
make the same sound in many names, the scheme dictates that they be coded identically.

However, there are classes of surname for which it works poorly. For instance, Van Hooten is 
coded ‘V 535’.    People researching that surname may well wish that only the Hooten had been
coded, yielding ‘H 350’. In fact, the clerk doing the indexing may have done it either way. You 
may use the Soundex Calculator to determine the soundex code for any variety of your 



surnames that you wish.

Statistics
The database statistics provided will tell you the number of persons, families, events, 
repositories, sources, and all other things that make up your family database.



Find Text
Searches for the data you specify in the current view or database. To search for multiple 
occurrences of specified data, you can use the Find Next button in the Find dialog box, or you 
can close the dialog box and press Shift+F4. Use Replace to both Find and Replace.

Find What
Type the string you want to find in your database. You can use wildcard characters to make the 
search more general.

Search
Select the direction of the search:

Up - Toward the first record from the current record.

Down - Toward the last record from the current record

All - Searches all records

Match
Click the drop-down arrow to display a list of search alternatives. Select which of the three you 
wish to be the default by use of the Options Dialog.

Any Part of Field - Searches for any occurrence of the text string. For example, searching 
for berg finds Bergen and Heidelberg.

Whole Field - Recognizes a match only when the text string matches the complete 
contents of the field. For example, searching for London finds London, but not Londonderry.

Start of Field - Searches for the text string at the beginning of a field. For example, 
searching for berg finds Bergen, but not Heidelberg.

Match Case
Select if you want to search for the text string exactly as you typed it in the Find What section. 
For example, searching for Street finds Street, but not street or STREET.

Search Fields as Formatted
Select if you want to find data based on its display format. This would be the normal choice.

Current Field Only
Searches through all records in the current field only. Searching in the current field is almost 
always quicker than searching through all fields.

Find First Button
Finds the first occurrence of the text string in the table. This button is not available until you 
specify what you want to find.

Find Next Button
Finds the next occurrence (relative to the current position of the insertion point) of the text string 
you specify. This button is not available until you specify what you want to find.



Close Button
Closes the dialog box.

Shortcut
F7 or Ctrl+F



Replace Text
Finds an existing text string in the current view or database and replaces it with the string you 
specify. Use Find to search without replacing. You can access Replace from the Toolbar, from 
the Menu, or from the keyboard with Shift+F7 or Ctrl+H.

Find What
Type the text string you want to find. You can use wildcard characters to make the search more 
general.

Replace With
Type the text string that will replace the existing string.

Search
Select the direction of the search:

Up - Toward the first record from the current record.

Down - Toward the last record from the current record

All - Searches all records

Match Case
Select if you want to search for the text string exactly as you typed it in the Find What section, 
matching uppercase and lowercase letters. For example, if you want to replace references to 
Street, but not references to street, select this option.

Match Whole Field
Select if you want to match the text string with the complete contents of a field.

Current Field Only
Searches through all records in the current field only. Searching in the current field is almost 
always quicker than searching through all fields.

Find Next Button
Finds and highlights (but doesn't replace) the next occurrence of the text string you specified in 
the Find What box.

Replace Button
Replaces the highlighted text and finds the next occurrence of the text string. If you don't want 
to replace a particular occurrence of the string, choose the Find Next button.

Replace All Button
Replaces all occurrences of the text string without stopping for confirmation. You can use this as
an alternative to repeatedly pressing the Replace button.

Close Button
Closes the dialog box.





Wildcard Characters
The asterisk (*), question mark (?), number sign (#), exclamation point (!), hyphen (-), and 
brackets ([ ]) are wildcard characters. You can use these characters in queries, commands, and 
expressions to include all records, file names, or other items that begin with specific characters 
or match a certain pattern. You can also use wildcard characters and matching characters to 
further refine a FindH or Replace search.

* Entering ‘wh*’ (without the quotes) finds what, white, and why.
Entering ‘*at’ finds cat, bat, and what. Like the MS-DOS asterisk (*)
wildcard character, this asterisk matches any number of characters. But
unlike MS-DOS, it can be used as the first character in the search string.

? Entering ‘b?ll’ finds ball, bell, and bill. Like the MS-DOS ? wildcard
character, this symbol matches any single character.

# Entering ‘1#3’ finds 103, 113, 123. This symbol matches any single digit.

[ ] Entering ‘b[ae]ll’ finds ball and bell but not bill. This method matches
any single character within the brackets.

! Entering ‘b[!ae]ll’ finds bill and bull but not bell. This method matches
any character not in the list.

- Entering ‘b[a-c]d’ finds bad, bbd, and bcd. This method matches
any one of a range of characters.

Note:    The wildcard characters

* Asterisk,
? Question mark,
# Number sign, and
[ Opening bracket

can match themselves only if enclosed in brackets. For example, to search for a question mark, 
you would enter [?] in the Find dialog box.



Character Set
The following table shows the character and the ANSI code in sort sequence. This is the 
Windows character set that addresses English, French, German, Portuguese, Italian, and 
Modern Spanish. The ANSI codes for the extended character set shown can be entered by 
using the ALT key and the numeric pad digits on your keyboard (see International Settings in 
your Windows manual). If you plan to transfer your data to another program that only reads 
plain text, it may not recognize the extended character set.

Char ANSIcode Char ANSIcode Char ANSIcode Char ANSIcode

0 48 D 68 k 107 U 85
1 49 d 100 L 76 u 117
¹ 185 Ð 208 l 108 Ù 217
2 50 ð 240 M 77 ù 249
² 178 E 69 m 109 Ú 218
3 51 e 101 N 78 ú 250
³ 179 È 200 n 110 Û 219
4 52 è 232 Ñ 209 û 251
5 53 É 201 ñ 241 Ü 220
6 54 é 233 O 79 ü 252
7 55 Ê 202 o 111 V 86
8 56 ê 234 Ò 210 v 118
9 57 Ë 203 ò 242 W 87
A 65 ë 235 Ó 211 w 119
a 97 F 70 ó 243 X 88
À 192 f 102 Ô 212 x 120
à 224 G 71 ô 244 Y 89
Á 193 g 103 Ö 214 y 121
á 225 H 72 ö 246 Ý 221
Â 194 h 104 Õ 213 ý 253
â 226 I 73 õ 245 Ÿ 159
Ä 196 i 105 P 80 ÿ 255
ä 228 Ì 204 p 112 Z 90
Ã 195 ì 236 Q 81 z 122
ã 227 Í 205 q 113 Þ 222
Å 197 í 237 R 82 þ 254
å 229 Î 206 r 114 Ø 216
B 66 î 238 S 83 ø 248
b 98 Ï 207 s 115 Œ 140
C 67 ï 239 Š 138 œ 156
c 99 J 74 š 154 ß 223
Ç 199 j 106 T 84 Æ 198
ç 231 K 75 t 116 æ 230



Reports and Printing
The Print Control allows the choice of reports to print. You may choose the Family Group 
Report, Person Report, Descendancy Report, the Pedigree Report, or one of a number of List 
reports. You may print the active or selected view, or report. To specify a printer and its 
connection, choose the Setup button.

Preview
Previews the selected report, and the selected records to be printed on that report. The number 
of records to be previewed (and therefore printed) will first be displayed to allow cancellation if 
desired. While viewing the Preview, use P to print, S to open setup, Z to zoom (or unzoom), and
C to cancel. You may also click on the preview itself to zoom that portion of the report.

Additionally,    you can cause Family Matters to remember, Forget or Recall the current View 
window size and screen position. Family Matters will automatically recall the size and position 
each time the View is opened.

Setup
Displays the default printer and printer connection dialog box. Also margins, paper source, and 
other printer-specific settings can be changed independently for each report type, and 
remembered for next time’s use. The upper and left margins should be set to allow one 
Pedigree Chart per page, and the width of one Group View Report per page. You may wish to 
change the margins if, for instance, you print on A4 size paper instead of 8 1/2 by 11 inches. 
You may also choose to print ‘text only’, if you don’t want the lines and graphics on some 
reports.

Print
Prints the selected records on the selected report. The number of records to be printed will first 
be displayed to allow cancellation if desired.

Output
Outputs the selected records on the selected report    to one of a number of file formats including
HTML, RTF, TXT, and others.

Report Selection
Specify the report you want to print or to preview.

Chronicles - Allows preview, printing, and setup of the Chronicles Report. This report is 
prints the contents of the Chronicles View.

Descendancy Chart - Allows preview, printing, and setup of the Descendancy Report. This
report is printed in its entirety, rather than by selecting records. The data printed is the same
as on the Descendancy View. You must generate the data    using this View before you can 
print the report.

Event List - Allows preview, printing, and setup of the Event List Report. This report is 
similar to the list portion of the Event View.

Family List - Allows preview, printing, and setup of the Family List Report. This report is 
similar to the list portion of the Family List, but with the addition of birth dates for the 



spouses.

Family Group - Allows preview, printing, and setup of the Family Group Report. Each 
Group Report may span multiple pages, depending on the number of children and the 
amount of Notes data you have entered, and events that are present in the database. The 
data printed is the same as is viewed on the Family Group View, with the addition that all 
events will be shown, in date order, on the printed report.

Pedigree Chart - Allows preview, printing, and setup of the Pedigree Chart Report. Each is 
one page. The data printed is the same as the Pedigree View.

Person List - Allows preview, printing, and setup of the Person List Report. This report is 
similar to the Person List, but with using two columns on the page.

Person - Allows preview, printing, and setup of the Person Report. This report is very 
similar to the Family Group report, but represents the data for a person. Each report may 
span multiple pages, depending on the amount of you have entered.

Repositories - Allows preview, printing, and setup of the Repository Report. This report is 
prints the contents of the Repository View.

Sources - Allows preview, printing, and setup of the Sources Report. This report is prints 
the contents of the Source View.

Print Criteria
Specify the records you want to print.

All - Prints all the pages of all the selected records.

Current - Prints the pages the Group View or Pedigree Chart most recently displayed.

Surname - Prints selections from the Family, Person, and Event Lists, or the pages the 
Group, Person, or Pedigree Chart having the selected surname. For instance, you may 
print all the Smiths in your database. Note that all surnames in the database are available in
the dropdown list, though you may not have Family Group Reports or Pedigree Charts for 
all those surnames.



Web Site Generation
Family Matters will generate a professional-quality World Wide Web site for you, using your 
genealogical data. The basic arrangement of the web site is determined by Family Matters, but 
you will have considerable control over the content and presentation of the material. You will be 
able to choose families and persons to be included or excluded, you can write text and 
designate pictures that Family Matters will use. You will need to have an Internet Service 
Provider (ISP) that allows users to upload HTML (Hyper-Text Markup Language) to be 
accessible on the web.

You can also use the Event Dictionary to determine which events in your database will be output
to your genealogical web site. By default, Birth, Baptism, Christening and Marriage are, but you 
can add to them, or remove some; whatever you choose.

Family Matters also generates a special person index file for your web site, named gendex.txt. 
This file will allow you to become a part of a network of genealogical web sites (if you want) that 
can be searched from a central site. Information about gendex is provided below.

Action Buttons
The buttons down the right side of the allow you to generate a test page, generate a full site, 
generate only pages that have changed, and obtain Help. 

Generate a Test Page - This button causes Family Matters to generate a single file names 
testpage.htm. You can view this file with you browser to ensure your family files to be 
uploaded onto your web site have the look you want.

Full Site Generation - Use this button to generate a full genealogical web site. Family 
Matters will then replace all files in your designated directory with newly generated files, 
whether or not they had changed.

Generate Only Changes - Use this button to generate and replace only files that have 
changed. Family Matters will compare the content of the files on your computer with newly 
generated files. If different, the old one will be replaced. If the same, no change is made. 

There are six tabbed pages on the Web Site generation dialog. They are general, welcome, site 
contents, family pages, family appearance, and indexes.

General Tab

Web Site Title - This is the text you want to identify you web site with. Something like 'John 
Doe's Genealogy' is appropriate. Don't include any HTML tags. This text will also be used 
as part of the identifying title of each of your pages. It will part of the identifier of someone's 
bookmark, and browser window caption.

Search Engine Keywords - This is text to help identify your web site to some of the 
automated World Wide Web search engines. This text will become part of your home page 
file (e.g., index.htm, frames.htm), and your Welcome Page file, though it will not be visible 
to you on your web site. The text you certainly should include here is the surnames of your 
direct ancestors, and any other text you think will help to identify your content to a Web 
search engine.



E-Mail Address - This is your complete e-mail address that someone will send e-mail to, 
for commenting on your web page, or to discuss a branch of your family to which they may 
connect. 

Home Page File Name - This is file name that will be given to your home page. It becomes 
part of the URL (Uniform Resource Locator - your World Wide Web address), that you will 
tell people    to come visit. The default is ‘index.htm’. This is the universal web site default 
file name. When your site is visited, the browser will automatically choose this file. Thus, 
you only have to tell friends and relatives to visit (for instance) 
http://members.aol.com/myname, rather than http://members.aol.com/myname/index.htm.

Directory to Build Site In - This is where you specify the directory (or folder) where your 
web site is to be built on your computer. The default is a directory named 'website', as a 
sub-directory of your Famat97 directory. Use an otherwise empty directory. All the files 
stored there will be for upload to your web site. The button will allow you to browse your 
computer.

Welcome Page Tab
This is where you specify the contents of the first page that visitors to your web site will see. 
Use this to introduce yourself, and your genealogy. Perhaps include a HTML link to a picture. 
This page, and the WebNote, behave identically.

The result is that you can include anything that you want. You can cause text to be bolded, 
underlined, italicized, or even include scanned pictures. If you are familiar with HTML tags, you 
can include anything that would appear in the 'Body’ of a HTML document. For more 
information, see HTML, below.

Site Contents Tab

Persons Included - Allows you to choose whether you want you entire database included, 
or whether you wish to exclude those who are still living. You can also choose whether to 
include persons with birth (or other) events of more than 75 or 100 years ago. Additionally, 
you can select specific persons and families for inclusion and/or inclusion (on the respective
Person View and Family View). If you have many persons in your database without events, 
you may want to add estimated birth dates, or simply add a death event, if you know them 
to have died.

Person Name Format - You can choose between four varieties of generated name format; 
either First Last; First LAST; LAST, First; or Last, First.

Include a Help Using Page - Family Matters can include a page in your web site to assist 
visitors. The page includes information about the options you chose in making your site, 
and describes the make-up of the frames and data pages. You may want to initially include 
this page.

Include WebNotes - Selecting this option causes Family Matters to search the notes for 
each family and person for the keyword WebNote. Text with this identifier will be included in 
the web site with the associated person or family. Once Family Matters finds this keyword, it
will first ignore everything until the first end-of-line, if there is anything. Then it will include 
everything from this keyword until either the end of the note, or until the keyword EndNote. 



Family Matters will then cause this text to appear on the web just as you have formatted it, 
by converting your 'end-of-lines' to 'line-breaks'. All other text is passed unchanged.

Include Chronicles - Selecting this option causes Family Matters to include the Chronicle 
items you have designated for the life and times of your ancestors, the places they lived, 
and their way of life. The text of a Chronicle behaves exactly the same as a WebNote.

Families Per File - This is the maximum number of families that will be output in each 
HTML file. The more families per file, the larger each file. The smaller the files, the faster 
they will be downloaded and displayed on browsers viewing your web site. The default is 
six, which will produce files as large as about 12 KB.

Family Pages Tab

Page Background - If you want, specify a background image to be used as the 
background of your web pages. Or, choose a color to use. If you know how to specify color 
using the standard HTML hexadecimal encoding #rrggbb, Family Matters will accept it. If 
you don't specify anything, plain white will be used.

Line - Family Matters places a horizontal line between families on the same generated 
page. You can choose its color and its height, in pixels. Or, you can specify the name of a 
graphic file you will upload to separate families.

Footer Contents - Family Matters places a footer at the bottom every family page 
generated. You can choose whether or not you want your e-mail address included, whether 
or not you want the date this page was generated, and whether or not the Family Matters 
version and link is included.

Family Appearance Tab
Each family on you website will generally be represented in three table-like structures. You can 
set the background default appearance of the tables, the appearance of the table borders, and 
the appearance of the cells within the table. 

Table Background - If you want, specify a background image to be used as the 
background of your web pages. Or, choose a color to use. If you know how to specify color 
using the standard HTML hexadecimal encoding #rrggbb, Family Matters will accept it. If 
you don't specify anything, the page background you chose will appear.

Table Border - Like the line (above) that separated the families on your page, the size (in 
pixels) and color of the border can be set.

Cell Padding and Spacing - Like the line (above) that separated the families on your page,
the room between the cells in the table (in pixels) can be set..

Table Background - If you want, specify a background image to be used as the 
background of your web pages. Or, choose a color to use. If you know how to specify color 
using the standard HTML hexadecimal encoding #rrggbb, Family Matters will accept it. If 
you don't specify anything, the page background you chose will appear.

Indexes Tab



Persons Indexed - There are five indexing strategies you can choose from. This selection 
effects both the Person index which will be displayed on your web site, as well as the 
content of the gendex.txt file that will be produced.

You can choose to limit the indexes produced to only people you have designated to be 
related to you, allow all people in families in your database to be included, or combinations 
of the above. If one of the ‘Relations’ selections are chosen, Family Matters will index only 
those persons with relationship text, and not starting with the letters 'no' or 'unkn' (this is to 
exclude those you might have designated 'Not Related', 'No Relationship Known', or 
'Unknown').

Generally, the choices tend from most restrictive to least restrictive. The choices are: 
‘Primary & Spouse Relations’ (only persons shown as Primary and/or Spouse, and related 
to you), ‘All Primary and Spouse’ (only persons shown as Primary and/or Spouse, whether 
related to you or not), ‘All Relations’ (only persons related to you, wherever they may 
appear on your web site), ‘Primary & Spouse & Relations’ (persons shown as Primary 
and/or Spouse and/or related to you - this is the default) and ‘All Persons’ (all persons on 
your web site).

Sort Person Index - You can choose how Family Matters sorts the Person Index.

Generate Family Index - You can choose whether or not a Family Index is also generated 
in addition to the Person Index. The sort method will be the same as the person Index sort 
method.

About Gendex
Family Matters produces a gendex.txt file of the persons represented in your web site. This file 
allows you to participate in the World Wide Web Gendex Project. You family members will 
become a part of a large, searchable distributed database made up of genealogical web sites 
with this important file.

Contact Chris Perry’s GenMatch, at 
http://206.139.152.113/GenMatch/genmatch.htm

Contact Tim Doyle's GenWeb Index, at
http://www.gentree.com

Contact Gene Stark's Gendex Web Search project, at
http://www.gendex.com

HTML
You can make use of the Hyper-Text Markup Language to any extent you wish in WebNotes and
on your Welcome page. The simplest items are <b>this text is bolded</b>, <u>this text is 
underlined</u>, and <i>this text is italicized</i>. To add a picture, centered horizontally on the 
page, put <center> <img=‘picturename.gif’> </center> in line in your text.

If you want to get more creative, buy a book on basic HTML, or search the web for one of the 
many sites with an explanation and examples of HTML. If you're interested, some sites to visit 
are:

NCSA’s Beginner’s Guide to HTML, at



http://www.ncsa.uiuc.edu/General/Internet/WWW/HTMLPrimerAll.html

Web Design Group, at
http://www.htmlhelp.com

How'd They Do That With HTML, at 
http://www.nashville.net/~carl/htmlguide/

Files
The files generated by Family Matters are listed as follows:
index.htm This is the file with the frame definitions. This is the first file you want visitors to 

open. This file tells their browsers how to view the other files. See the discussion 
above on Home Page File Name.

title.htm This file contains the title of your web site, and appears in the top pane.
tocfam.htm This is the Family index, and appears in the left pane.
tochron.htm This is the Chronicles index, and appears in the left pane.
tocind.htm This is the Person index, and appears in the left pane.
Using.htm This is the file that contains instruction for visitors on how to use your web site.
welcome.htm This is your welcome page. It appears in the right (or main) pane.
_1*.htm Files that begin with ‘_1’ are the Chronicles files.
_*.htm Files that begin with ‘_’, followed by alphabetic letters, are your Family files.

Considerations
Once you have generated a web site, the Person, Family, and Chronicle views will provide you 
with the URL (Uniform Resource Locator) value of the persons, families, and chronicle pages in 
your web site. You can paste these string into WebNotes or the Welcome page as you like, to 
provide links to particular people and families in you web site. They can be used from outside 
your web site, but then the complete URL of your site must be included.

Within your site, the HTML text <a href=”_jones1.htm#F1234”>Fred Jones</a> will be sufficient 
to get you to that place within that file. But from another site, the full Internet URL is necessary, 
such as:
<a href=”http://members.aol.com/fredjones/_jones1.htm#F1234”>Fred Jones</a>

As long as the 'Families Per File' setting remains constant, your families will always be output in 
the same file, and thus always have the same URL as earlier web site generation efforts. The 
'Persons Included' setting may effect whether or not persons are output, but they will always 
remain in the same place in the same file. This rule will however be broken when the number of 
files required to represent one of your surnames requires more digits that previously. As an 
example, the file in the above URL would become ‘_jones01.htm’ when there becomes more 
than nine ‘_jones’ files, and then again when there is more than 99 (becomes ‘_jone001.htm’). 
Note also that in the last example, the s in Jones was dropped to make room for the additional 
digit.

One More Thing
When you get your web site up and running, drop me (Ray Nicklas) an e-mail message at 
ray@matterware.com. Tell me your URL, and a few words about your site, and the number of 
persons and families. Also, let me know about any other customization of features you would 
like to see built into Family Matters, or any neat customization you’ve done in you web site.





GEDCOM Import / Export
GEDCOM was developed by the Family History Department of the Church of Jesus Christ of 
Latter-day Saints to provide a flexible and uniform format for exchanging computerized 
genealogical data. GEDCOM is an acronym for GEnealogical Data Communication. GEDCOM 
is provided to foster the sharing of genealogical information and the development of a wide 
range of inter-operable software products to assist genealogists, historians, and other 
researchers.

Family Matters' GEDCOM export facility complies with GEDCOM Standard Release 5.5, dated 
11 December 1995. Its import capability complies as well as aspects of earlier releases for 
compatibility with other programs. The GEDCOM Import / Export Control allows data generated 
in another program (or another Family Matters) to be imported. It also allows the export of your 
data, to the same standard, for import into another genealogy program.

Considerations
The Relationship and Sibling fields are unique to Family Matters. Hence, you may not wish to 
export this data unless you anticipate the file will be imported by Family Matters. The GEDCOM 
import and export processes, especially for large files of over 10,000 persons, can be time 
consuming. You may want to perform these operations without any data views displayed, to 
allow as much free memory as possible, and thus minimize the time consumed.

Import Button
Tells Family Matters to begin the specified GEDCOM import.
 
Export Button
Tells Family Matters to begin the specified GEDCOM export.

Progress Bar
Indicates the operation that Family Matters is currently performing during the import and export 
process.

Data & Control Tab

Source and Version - On import, indicates the source of the GEDCOM data. On export, 
Family Matters.

Date - On import, indicates the date the GEDCOM file was created. On export, today.

Destination - On import, indicates the destination indicated by the person preparing the 
GEDCOM. On export, your choice. Generally accepted values are:

FamilyMatters - Default value
ANSTFILE - LDS Family History Department for Ancestral File
TempleReady - LDS Temple submission

GEDCOM FILE - On import, use the associated file open button to specify the desired file. 
On export, you specify the desired file name and path. Default is the Family Matters data 
file name, with a .ged extension.

FM Data File - The name of your Family Matters data file.



Name - On import, indicates the name of the person preparing the GEDCOM. On export, 
your name should be here.

Address - On import, indicates the first address line of the person who prepared the 
GEDCOM file. On export, your street address should be here.

Address2 - On import, indicates the second address line of the person who prepared the 
GEDCOM file. On export, your city and state (or province) should be here.

Address3 - On import, indicates the postal code of the person who prepared the GEDCOM
file. On export, your postal (or zip) code should be here.

Phone - On import, indicates the phone number of the person who prepared the GEDCOM 
file. On export, your phone number should be here.

Import Export Options Tab

Export Relationships - Yes or No. Export the Relationship field information to the 
GEDCOM file. Relationship is not a standard GEDCOM file data item, hence it will generally
not be used by another program, but might be read as a Note field.

Import Relationships - Yes or No. Indicate whether you want to import the Relationship 
field information from the GEDCOM file. You would not wish to do this if the relationship 
data is relative to someone else.

Export Chronicles - Yes or No. Export the Chronicles information to the GEDCOM file. 
Normally this would be set to Yes. You might choose to set it to No if the export was strictly 
for a GEDCOM matching service, rather than for someone to import and use.

Export Repositories - Yes or No. Export the Repository information to the GEDCOM file. 
Normally this would be set to Yes. You might choose to set it to No if the export was strictly 
for a GEDCOM matching service, rather than for someone to import and use.

Export Sources - Yes or No. Export the Sources information to the GEDCOM file. Normally
this would be set to Yes. You might choose to set it to No if the export was strictly for a 
GEDCOM matching service, rather than for someone to import and use.

Export Pictures - Future capability.

Export Sibling Number - Yes or No. Export the Sibling Number field, which represents 
birth order, to the GEDCOM file. Sibling Number is not a standard GEDCOM file data item, 
hence it will generally not be used by another program, but might be read as a Note field.

Export Notes - Yes or No. Export the Notes field information to the GEDCOM file. Normally
this would be set to Yes. You might choose to set it to No if the export was strictly for a 
GEDCOM matching service, rather than for someone to import and use.

Export Web Notes: Yes or No. This option only appears when Export Notes is selected. 
Normally this would be set to No. You might choose to set it to Yes if the export was strictly 
for your own use. Generally, others might not be interested in data which might be 



extraneous.



Databases and Files
The Family Matters uses a Lineage- and Event- Linked Relational Database. Persons and their 
data are stored in a table of persons, and have links which ‘point’ to their parents' table entries. 
Another table, the family table, has links which ‘point’ to the primary persons and spouses, and 
contains the marriage information. Events and Roles are stored in a table of events. Each event 
entry ‘points’ to the family or person entry with which it is associated. The pedigree data table 
contains links to the persons who are shown as the primary and spouses on the Pedigree View. 
The descendancy data table contains the last descendancy chart you generated. Each person's
entry ‘points’ to their corresponding entry in the person table. Family Matters reads and 
interprets all this information to provide you with Family Group Sheets, Pedigree Charts, and 
Descendancy Charts to assist you in organizing, researching, viewing, and maintaining your 
family's history.

If you are using Family Matters in a multiuser environment, then you and your workgroup 
members may wish to simultaneously open the same database. The database you open will 
need to be placed in a directory that is shared across a network. While one person is viewing 
data, others might be working in the same database, and changing, adding, viewing, and/or 
deleting the same or related data. The only restrictions that exist are on a record basis. That 
means that if two users are modifying the same record at the same time, only one user's 
changes to a record will be stored into the database. The other user will be notified. You will 
want to use the Save Record function to complete your changes and allow the other user to 
proceed. Multiuser Considerations has more information on this topic.

The Family Group View appears to view a single record at a time in the Family Group database.
In fact, it allows you to view the contents of many records at the same time. As you step through
the family data table, the Group View displays to you the data for the six persons making up the 
Primary, Spouse, and both sets of parents. Additionally, all the children who are products of this 
family, and some of their person data, are shown in a scrollable area.

As an illustration, when you are on the Family Group View and your click on the button of a child
or parent elicits the question ‘Family record does not exist, create?’, it's because you are on the
‘ragged edge’ of your database. There is a table entry for the person, but no family table entry 
‘pointing’ to that person as a Primary or Spouse. This makes good sense for children who have 
not yet struck out on their own, and for parents of persons who might be unrelated to you (like 
that guy that your sister married). You want to have his parents' names and person data, but 
you might not be interested in anything more about his family.

The Person View allows you to step through the data table containing all the persons. This 
presentation of your database shows all the persons in the database, whether related to you or 
not. The Person View also displays the parents' names of each person. Likewise, the Family 
Group View displays a summary of all the families in your database. By the way, the Database 
Statistics function shows you the total number of families and persons in your database.

Another database table used in Family Matters is the one viewed by the Pedigree View. This 
table contains links which ‘point’ to the person displayed as the primary (or root) of the chart, 
and to the spouse shown in the chart. You must, however, tell Family Matters the person who is 
to be the root of the chart. Family Matters ‘fills in’ the other persons and their vital statistics for 
you.



Family Matters provides you capability to account for multiple spouses. There is no reason why 
the same person cannot be ‘pointed to’ by many family table entries. When you do this, be sure
to use the Create facility provided by the Family Group View, rather than create a second 
person table entry for the same person. Of course, you may wish to only choose one spouse, 
and address the others in the Notes text area. You can choose the blood relative, or the spouse 
with which most children were had (or the current spouse if you are friends).

Database Upgrades
As the capabilities of Family Matters improves with the release new versions, the database will 
occasionally be upgraded to include the data structures necessary to support the new features. 
If your database was begun with an earlier version of Family Matters’ database, you may be 
prompted to upgrade your database prior to proceeding. The following summarizes the 
database changes that have occurred. Additionally, there are functionality changes to Family 
Matters, summarized in the accompanying file, VERSIONS.TXT.

Directories In Your Computer
The default installation folder on your computer for Family Matters is C:\Program Files\Family 
Matters 97. You can change the installation directory at the time of installation. Should you 
upgrade your version, there are files that should be copied into that directory. Or, you can install 
the Family Matters 97 upgrade by using setup.exe if you have the full installation set, but make 
sure you choose the same directory as when you initially installed.

Though you can store them anywhere you wish, the default database directory on you computer
for Family Matters 97 is C:\My Documents\Famat97\FmData\. Other data will default to part of 
the same structure. For instance, the web site default will be C:\My Documents\Famat97\
WebSite\, and the pictures default will be C:\My Documents\Famat97\Pictures\.

To 4.01. This database version represents the first 32-bit version, and is the native database 
version of Family Matters 4.01. Family Matters 4.01 can also inter-operate with database 
version 3.30, although with reduced performance. Version 4.01 uses a full 32-bit database, and 
also includes improved indexing schemes designed to improve performance, especially with 
large family databases.

To 4.02. This database upgrade corrected errors in the earlier database version. Also, 
incorporated database changes unique to Family Matters 4.02, and thus ended the transitional 
inter-operability with 16-bit database version 3.30.
 
To 4.03. This database upgrade corrected errors in the earlier database versions, like a 
recalculation of soundex values with the corrected function, and helped to set up database 
variables changes for later feature changes (like pictures). 

To 4.10. This database upgrade is the first to support linking pictures to persons and persons to 
pictures. The pictures which were previously viewable on the Group View are no longer, and 
instead are linked and shown on the new Picture View.



Compact Database
To make the best use of your memory and disk space, you may want to periodically compact 
your database. Compacting makes a copy of the database, rearranging how the database file is 
stored on disk if it is fragmented. File storage can become fragmented when you make many 
changes to a database. The compacted database file is usually smaller and often provides 
better performance.

Additionally, compacting reduces the file size by removing space once consumed by deleted 
records. Furthermore, since a Family Matters database space is only data (although a field may 
allow 250 characters maximum, it only uses as much space as is required), compacting will 
remove the space once used by fields.

If you are in a multiuser environment, you will not be able to compact the database if other users
have the database in question currently open. Also, the compaction process will be quicker if 
you perform the compaction from the computer in which the database is resides.

The Files menu contains the Database Compact selection. This choice will cause your current 
database to be compacted. This may take a few seconds to a few minutes, depending on the 
size of your database.

If the database is compacted successfully, the original file is replaced with the compacted 
version. The compact operation succeeds only if you have enough storage space on your disk 
for both the original and compacted versions of the database. The original will still be on your 
disk as .old.

Databases can also be compacted by use of a command line option. The command ‘acrn200 
DataBaseName.mdb /compact’ will cause compaction of DataBaseName. Both /compact 
and /repair can be used on the same command line.



Repair Database
Repairs a corrupted database. The database can only become corrupted if Family Matters were 
to quit unexpectedly: for example, if there is a power outage or your computer experiences a 
hardware problem. The database will not become corrupted if you exit normally.

If you are in a multiuser environment, you will not be able to repair the database if other users 
have the database in question currently open. The process will be quicker if you perform the 
repair from the computer in which the database is resides.

The File menu contains a Database Repair selection. This choice will cause your current 
database to be repaired. This may take a few seconds to a few minutes, depending on the size 
of your database.

Databases can also be repaired by use of a command line option. The command ‘acrn200 
databasename.mdb /repair’ will cause repair into the same file name. Both /compact and /repair
can be used on the same command line.

When you open or compact a corrupted database, Family Matters may ask if you want to repair 
the database. If you choose OK, Family Matters repairs the database. In some situations, 
Family Matters may not detect that a database has become corrupted. If a database behaves 
erratically, use Repair Database to repair it.



Multiuser Considerations
Family Matters makes Multiuser Genealogical Computing transparent to the users. There are no
special settings to be made to allow or disallow this feature. This is the same mechanism that 
allows a single user to view the same records using multiple views at the same time.

Database Location
The database you wish to share will need to be placed in a directory that is shared across a 
network. Each computer requiring access will need its own copy of Family Matters. The copy of 
Family Matters running in the computer in which the database resides will have the fastest 
access.

While one person is viewing data, others might be working in the same database, and changing,
adding, viewing, and/or deleting the same data. The only restrictions that exist are on a record 
basis. That means that if two users are modifying the same record at the same time, only one 
user's changes to a record will be stored into the database.

Requery
You will be able to view the data changes made by another user in the database within 60 
seconds after they are saved. However, your view of the records will not be reordered, new 
records will not be displayed, and deleted records may display with #deleted in the fields. To 
fully update your view and obtain the latest, properly sorted data, either close and then re-open 
the window you are using, or simply depress shift-F9.

Record Locking
For maximum group and person flexibility, Family Matters sets no record locking. The effect of 
this becomes a consideration beginning when you start to edit a record, and ending at the time it
is saved. In database parlance, this is the time period in which that record's data is ‘dirty’. 
Others may view the record while your copy of the record is dirty, but they will see the old data. 
Your changes will become viewable by the other users within 60 seconds after your changes 
have been saved.

Another user may edit the same record. If those changes have already been saved, you will be 
notified when you attempt to save your changed data. The options presented to you will be to 
(1) overwrite, (2) copy your changes to the clipboard, or (3) discard your changes. Since the 
other user's database transactions have already been completed, and could have involved 
linkage modifications (invisible to you), your best alternative is to choose discard. Any other 
choice could cause unpredictable results.

Linking, Unlinking, and Deleting
Linking, unlinking, adding and deleting can modify the records of many more persons than just 
the ones you are physically viewing. For instance, when you add a spouse to an existing family, 
Family Matters will modify all of the records of the children to ‘point’ to the new mother or father,
and each record so modified will be briefly dirty as it is modified. The best arrangement is to 
restrict only one user to this type of database operation, and (for best performance) seat that 
user at the computer on which the database is physically located. 

StartUp and Shutdown Procedures
Should the computer with the database become inaccessible to Family Matters, you may view a
sequence of error messages from the database engine. Just continue to click on OK until you 



are able to normally exit Family Matters.

Should you wish to again use the same shared database you were using on another computer 
when you last exited Family Matters, make sure that computer and file is available before 
starting Family Matters. When you start Family Matters it will attempt to reattach to the database
that was last in use. If it is inaccessible, you will be notified, and can open another database.



Support
This Help file is your first line of support. There is also an Interactive Manual Envoy file supplied 
with Family Matters, intended as a manual that can be printed and read off line. It contains 
expanded information similar to that available in this Help file. If you have the WordPeferct 
Envoy product, you can also annotate and save the file.

If you require additional support, or have suggestions about enhancements, send e-mail to the 
author, Ray Nicklas, at Ray@matterware.com, or fax to (904) 734-8674.

Free updates, and the latest news about the product, are always available at the ‘MatterWare 
On The Web’ home-page at http://www.matterware.com.




